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1 Overview

LogWorks is a software application that interfaces with the Innovate Modular Tuning System
products. It enables easy analysis and manipulation of engine data acquired by MTS components
and also allows to view engine data in real-time on the on-screen virtual gauges.

This manual describes the basics of data logging with the Innovate Modular Tuning System and
how to use the LogWorks 2.0 Program.
In addition this manual shows how you can extend the capabilities of the MTS with some basic

electronic skills.

1.1 Specifications

Computer requirements
Operating System
Computer speed

RAM

Hard Disk space

Display

Other

LM-1

Firmware version required
LM-1 Input Impedance

LM-1 Dynamic Input Impedance
Data logging rate

LM-1 Max. Logging time internally

LM-1 Max number of sessions intern.

LogWorks limits

Max. Session Size
Max. Number of sessions per log
Max. Number of logs open

Windows 98 or later

500MHz Pentium 1 or faster

Min. 48 Mbyte

Min. 100 Mbyte free space

Thousands of colors, 800 x 600 Min.

1 free serial port or USB to serial adapter

1.1 (1.33b or later recommended)

>1 MOhm (- 0.5 to + 5.5V input range)
<10 kOhm (< - 0.5V or > 5.5V input range)
Low pass filter 10 kOhm / 4700 pF

12.21 times/second for all inputs concurrently
Equivalent to 81.92 msec per data set

44 minutes

1024

1 hr 45 minutes
1024
32 open concurrently
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2 Logging engine data

2.1 Datalogging 101

Data logging is basically the recording of engine data. Engine data is measured with various
sensors. Two types of logging are common.

a. Time based logging
b. RPM based logging

In time based logging the sensor data is read in fixed time intervals. This is similar to how a movie
projector or a TV works. In a movie, a snapshot of the camera scene is taken 24 times per
second. Because of the limited speed of the human eye, these snapshots, when viewed at the
same sample rate of 24 snapshots per second, seem like continuous motion to the human eye.

Time based data logging works the same way. A snapshot of the engine state is recorded at fixed
time intervals.

RPM based logging is mainly used in conjunction with chassis- or engine-dynamometers. Their
purpose is to measure power and torque curves of an engine in relation to RPM. Typical RPM
interval is every 50 RPM. Although this serves its purpose, time-dependent dynamic effects can’t
be analyzed with this logging method.

A time based recording can be converted into an RPM based recording (LogWorks has that
capability), but an RPM based recording can’t be converted back into a time based recording.

2.1.1 Definitions

Channel
A channel is the data from a single sensor, like AFR or RPM.

Sample
A snapshot of the engine state is called a sample. A sample can contains the data of many
channels, but they are all measured ideally at the same time.

Sample Rate
The sample rate is the number of samples (snapshots) of engine data taken per second.

Channel Rate
The channel rate is the number of total channel measurements taken per second. It is the number
of sensors measured for each sample multiplied by the sample rate.

2.1.2 Logging speed

The data logging speed (samples per second) is dependent on what data is to be logged.
When logging engine data, 99% of the data changes no faster than about 5 times per second
(one state to another and back).

The engine state is ultimately controlled by the driver’s right foot. The fastest external muscle in
humans is the eye-lid muscle. It goes through one blink-cycle in about 100 milliseconds.
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A mathematician named Harry Nyquist found out (in 1928), that for anything that you want to
record, you only need to record at twice the maximum frequency contained in the recorded signal.
So, for the human eye-lid, the required minimum logging speed is 20 times/second. The human
foot, controlling a gas pedal, is much slower. Remember, the frequency is not measured from idle
to WOT, but from idle to WOT and back.

The second parameter determining the logging speed is the statistical nature of the combustion
process itself. No two combustion events in an engine are identical. Therefore, to get meaningful
data, multiple combustion events must be averaged to see the overall effects. If each combustion
event is analyzed and recorded, meaningful tuning data can't be seen in most cases. At 6000
RPM an engine goes through 50 engine cycles per second (a 4-stroke engine cycle requires two
rotations per cycle). At a logging speed of 12.5 samples per second this would mean that the
resulting data is the average of 4 engine cycles.

The above means that data logging engine data needs to be done at 10-15 samples per second.
Anything more creates only more data points which do not contain any additional information, but
are harder to analyze.

The Innovate Modular Tuning System samples engine data at 12.2 samples/second.

NOTE:
This sample rate is the rate for a sample containing multiple sensor data, each sampled at
the same time instance, NOT the total channel rate.

When evaluating data-logging products be very aware of the difference between channel rate and
sample rate. Many manufacturers specify the channel rate, but claim it as sample rate.

For example if a data logging system records 30 data channels, but reads each in turn only once
per second, the channel rate is 30 per second, but the sample rate is only 1 per second.

This is especially problematic if the channels are not sampled at the same instance in time, but at
whenever it is the turn for this channel to be read. The channel data, when taken and interpreted
as sample, do not correlate anymore, because each reflect the engine state at up to 1 second
apart and there is no way to correlate them.

Many OBDII based systems log this way because of the limited speed of OBDII, but some of the
manufacturers claim 30 samples or more per second.

Higher logging speeds

There are situations when higher logging speeds are needed. To analyze engine data on a crank
degree basis at a resolution of 1 crank degree, requires measuring at 72000 times per second at

6000 RPM ( 6000 * 360 degrees * 2 [Nyquist] / 60 ). The applications for this are very specialized.
An example is to analyze the point (in crank degrees) where flywheel acceleration is fastest. With
the availability of fast and cheap microprocessors today this data can be analyzed on the fly and

then the results logged (for example as max. acceleration point) at a much lower speed of 10-15

samples per second.

Another application for higher logging speeds is suspension analysis. There typically the shock
velocity needs to be known under various conditions. Measuring rates of 1000-2000 times/second
are required to calculate shock velocity and travel amplitude. But again, this data can be
processed on the fly and then get logged at lower speeds by modern microprocessors.
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2.1.3 Logging resolution

Logging most channels involves interpreting voltages. Typically for most of today’s sensors the
voltage range is 0..5V. When a data logger reads these voltages they are converted into a
number that is represented digitally. Converting the voltage to that number is the task of an
analog-to-digital converter (abbreviated A/D or ADC). The highest number a A/D can represent
conforms to the max. voltage it can read and also determines the finest resolution it can read.
The number of ‘bits’ of the ADC specifies that highest number. For example for an 8 bit A/D the
highest number is 255 (2 to the power of 8 minus 1). It could resolve the input voltage into 5/256
Volts. For a 10 bit A/D the highest number is 1023 and the resolution is 5/1024 Volts. So the
resolution for any sensor is:

Range / ( 2 to the power of [number_of bits]) or Range/2"N,
Where N is the number of bits of the ADC.

Most MTS devices that read external voltages or internal sensors use 10 bit resolution A/D’s. The
exception is the AFR/Lambda data.

Even though the Lambda range goes from 0.5 to infinite, it is limited for logging purposes to 0.5 to
1.523 Lambda, or possibly 0.5 to 4.595 Lambda.

In the first case it is then still a 10 bit range with a resolution of 0.001 Lambda. In the second case
it is a 10 bit range with a resolution of 0.004 Lambda.

The LMA-3 internally digitizes with a 16 bit ADC. It then uses the extra resolution to filter out
noise and finally reduce the resulting resolution to 10 bit for the MTS data stream.

NOTE:

LogWorks always stores all channel data in the 10 bit raw format as digitized. How the
numbers are interpreted for the user display depends on the user settable channel
configuration. But the raw stored 10 bit numbers will not get changed when the
interpretation changes.
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2.2 Sensors and the Modular Tuning System

The Innovate modular tuning system (MTS) consists of various devices to measure, digitize and
record various engine parameters. Typically these parameters are sensed by different sensors
built either into the engine itself or into MTS components. These sensors measure for example
temperatures, pressures, air-flow, air-fuel ratio and so on. Sensors convert the measured quantity
into an electrical signal, typically a voltage between 0 and 5V, which can be logged or displayed
by the MTS components. The sensors can be categorized generally into four different groups,
depending on the output they produce:

a. Voltage output sensors with external supply

These sensors have mostly 3 pins. One for the supply voltage (typically 5V), one for the
output signal, and one ground. Sometimes the ground pin is omitted and the sensor is
grounded through its metallic body to the engine. Typical examples are Throttle Position
sensors (TPS), Manifold Absolute Pressure sensors (MAP), and Mass Air Flow Sensors
(MAF). The output voltage has a typical range of 0..5V and varies for most sensors linearly
with the measured quantity.

b. Voltage generating sensors

These sensors generate a (small) voltage more or less proportional to the measured quantity.
Typical examples are Thermocouples and (Narrow-Band) O2 sensors. Thermocouples output
a very small voltage (in the microvolt range) that requires a special amplifier to make the
signal readable and loggable. The LMA-3 Auxbox has such an amplifier built in.

Narrow-Band O2 sensors output a voltage in the milliVolt range (up to 2000mV). Their
voltage output has a jump from low (~100mV) to high (700mV to 1000mV) when the AFR of
the exhaust gas changes from lean of stochiometric to rich of stochiometric. They act more
like switches than actual sensors. Basically they can indicate lean, rich and stochiometric.

c. Resistive sensors

These sensors change their electrical resistance with the measured quantity. Very often the
relationship between resistance change and the measured parameter is non-linear. Typical
examples are Intake Air Temperature Sensors (IAT), coolant temperature sensors (CT) and
some oil-pressure/fuel pressure sensors. Typically these sensors have 2 pins. One is ground,
the other is connected to a load resistor. Often the ground pin is omitted and the sensor is
grounded through its body to the engine. The other end of the load resistor is connected to a
voltage supply (typically 5V). The purpose of the load resistor is to form a voltage divider with
the sensor. At the connection between load resistor and sensor a voltage is formed that is
dependent on the resistance change of the sensor according to this formula:

Vout = Vsupply * Rs / (Rs + RL)

Were Vout is the output voltage, Vsupply is the supply voltage, Rs is the sensor resistance
and RL is the load resistor. For maximum sensitivity, RL is typically chosen to be equal to Rs
at the typical operating point.

A sensor that falls between resistive sensors and voltage output sensors with external supply
is the throttle position sensor. Although it is a resistor with a movable tap, it behaves looks
and interfaces exactly like a voltage output sensors with external supply.

d. Frequency sensors

-10- Logworks2_Manual_1.1.doc



These sensors output a signal that varies in frequency (oscillating voltage) with the measured
guantity. Examples are some MAF sensors, the tach signal that measures engine RPMs and
the vehicle speed signal generated by drive-shaft or wheel sensors.

The LMA-3 (Auxbox) has the capability to convert these frequencies into a digital or analog
signal that can be interpreted and logged.

The MTS components convert the sensor data to a digital number between 0 and 1023 or a total
of 1024 steps incl. 0. This is equivalent of a 10 bit resolution (210 =1024). The resulting
resolution for a 0..5V signal is therefore about 4.9 mV. Any signal variations smaller than that
cannot be resolved.

LogWorks has capabilities to convert the logged number back to the original quantity, provided
the characteristics of the original sensors are known. This means that LogWorks needs to know
how to convert the voltage output of the original sensor to the measured quantity equivalent.

The Air-Fuel-Ratio signal of the MTS components is not digitized from an external analog voltage.
Instead it is internally calculated. For logging purposes this signal is internally always stored as
Lambda with a resolution of 10 bits (1024 steps). To create the Air-Fuel-Ratio, the Lambda
value is multiplied with the stoichiometric ratio for the given fuel (like 14.7 for gasoline) by the
LogWorks software.

The datalog range for Lambda is 0.5 to 1.523, equivalent to 1024 steps with a resolution of 0.001
Lambda (for gasoline this is equivalent to a 0.0147 AFR with a range of 7.4 to 22.4 AFR). This
range is more than sufficient for spark ignited internal combustion engines. AFR/Lambda ranges
outside of the logging range are pegged at the minimum or maximum point respectively.

See the manual for the MTS device you are using for details on how to connect various
Sensors.

2.3 Sensor Hookup

Almost any sensor requires a ground connection. The voltage output of the sensor is referenced
to that ground. If the device measuring the sensor is connected to a different ground, the voltage
difference between the grounds can shift the sensor output voltage relative to the measuring
device. Some measuring devices, like the LMA-3, have differential inputs to compensate for that
offset. The negative side of a differential input is NOT a ground. It is intended to be connected to
the same ground as the sensor. A measuring device with a differential input measures the
difference between its own ground and the sensor’s ground on the negative input and subtracts
the difference from the measured voltage on the positive input to compensate for the ground
offsets. The hookup from a differential input requries two wires. One for the signal itself and one
for the ground reference. The ground reference input (typically named CHx-) goes to the
grounding point of the sensor.

Ground offsets are especially problematic for resistive and voltage output sensors. They are not
so important for frequency or duty cycle based sensors.

For a measuring device with common ground, like the LMA-2, it is best to ground all sensors at
the same point where the measuring device itself is grounded.

Ground offsets can also affect frequency or duty cycle based sensors. Typically when measuring
a frequency, the signal is measured as ‘high’ or ‘low’ depending on the measurement device’s
high-low threshold. In the LMA-2 or LMA-3 the threshold is 1V for the LMA-2 or 2.5V for the LMA-
3. Ground offsets of 1V or 2.5V will not allow the device to measure correctly.

Another problem can be ‘ground bounce’. If the signal generating device (for example an ignition
system) creates very high current pulses, it's ground can momentarily ‘jump’ over the threshold of
the measuring device because of the high current. These ‘ground-bounce’ pulses are measured
as false frequencies and can interfere with the measurement.
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Another problem in sensor hookup is called ‘induced noise’. In an engine compartment very high
current pulses are routed many different places. These current pulses can come from the
injectors, ignition system or alternator. Any (changing) current flowing through a conductor
creates a changing magnetic field. A changing magnetic field intersecting another conductor (for
example the sensor wires) will create a voltage along that conductor. This voltage is added as
noise to the sensor signal. This is how an antenna for radio signals works as well.

By twisting the sensor output and sensor ground wire together, that induced noise can be
minimized. Each twist creates a wire loop acting as small antenna to pick up the induced noise.
BUT, the noise induced in each loop changes polarity from loop to loop. This way each twist-loop
cancels out the noise from the previous loop. The tighter the twist, the more cancellation can be
achieved.
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2.4 The Innovate Log-Chain concept

LogWorks 2.0 has the capability to log, display and analyze up to 32 engine parameters. Most
users will use less though. Each of the MTS components reads between 1 and 6 (as of 6/1/05)
engine parameters. To interface a multitude of MTS components to LogWorks with a single
connection, the Innovate LogChain concept was introduced.

Each of the MTS components has two serial ports (except the LM-1, which has only one). One
serial port is designated as IN-port, the other as OUT port. The OUT-port of one device is
connected to the IN-port of the next device and so on. This way devices can be ‘daisy-chained’ to
build a log-chain for up to 32 channels total. The OUT-port of the last device is connected to the
computer for logging or downloading of logged data.

The following diagram shows how to connect multiple MTS devices to form a log-chain. The

example chain consists of a LM-1/LMA-2, a LC-1, a LMA-3 and 2 XD-1’s. In this case the chain
has 12 channels (6 from LM-1, 1 from LC-1 and 5 from LMA-3).

er Cer. 5 B, Er Ser. Ef Ser. Eumputer
auT ouT ouT ouT

Fras Lh4-3

Devices attached to the LM-1’s analog input count as being part of the LM-1's 6 channels. They
don’t count extra. XD-1's do not contribute any channels, so you can add as many as needed.

Another Example Log Chain (7 channels with 2 AFR channels):

Ser || Ser er Ser. Ser. er Ser. Ef Ser. Eumputer
M || ouT auT IN ouT ouT ouT
=rm|natur
Plug

(Arnold) ey, LA

The device that's first in the chain is special. It determines the logging sample rate. The first
device in the chain sends a data packet containing its channel data (a sample) to the next device
(downstream, left to right in the diagram) every 81.92 milliseconds. The next device appends its
data to that packet and hands that packet to the next device downstream and so on. At each
device the packet grows in length. The devices in the chain synchronize their sampling of the
engine parameters to the packets, so that all the channels in a packet together represent the
same instance in time. At the downstream end of the log chain (OUT-port of the last device) a
computer or external logger can be connected to store or display the stream data. The XD-1
display is such a device.

This also means that the complete channel data set is ONLY available at the end of the

log-chain. A datalogger capable of recording the log-chain data-stream therefore MUST be
placed at the end of the log-chain. This includes lap-top computers or other loggers.
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Commands for individual devices are sent ‘upstream’. A device (incl. a computer or an XD-1) can
send commands to the devices upstream of itself, but not downstream. Commands can include
start-stop recording, calibration/configuration commands and so on. Only the device directly
upstream of the command originator of course will receive the command. This device then
decides, depending on the command, whether to execute the command and whether to pass it
on. An example of a case where the command is executed but not passed on is the start-stop
record command. The first upstream device capable of logging internally will execute the
command, but not pass it on.

As said before, the first device is special because it is the synchronization source for the entire
chain. By plugging its IN-port with the supplied terminator connector, a device can detect that
requirement when it powers up. The terminator connector just connects the transmit and receive
line of the IN-port together. Each device sends a special command out on it's IN port when it
powers up. This command is ignored and not passed on by any device if received on it's OUT
port. If the sending device immediately receives that command on its IN-port again, because the
terminator is plugged in, it assumes it is the first and special device in the chain. The LM-1,
having only one serial port, is ALWAYS a special device and MUST be connected to the
beginning of the chain.

2.5 Identifying devices and Channels

To easily identify which channel is representing which engine parameter, the channels must be
given a name. Use short names to not use up a lot of screen real-estate.

USE ONLY NUMBERS AND LETTERS IN A CHANNEL NAME. THE ONLY SPECIAL
CHARACTER ALLOWED IS THE UNDERLINE CHARACTER _ .
A CHANNEL NAME MUST START WITH A LETTER.

LogWorks allows you to configure each channel. Part of the configuration is the name. Also the
color in which the channel is displayed is programmable in LogWorks as well.

To further easily identify the channels each MTS device MUST be given a name. This name can
be up to 8 characters long and is programmed into the device. Use the LM Programmer
application to change the name of a device. This is especially important when multiple devices of
the same type are used.

When LogWorks start up, it will identify the devices in the LogChain. If new devices have been
added or devices removed, LogWorks will automatically change its channel configuration to
reflect the new log-chain configuration. Channels associated with a device previously will stay
associated with that device, even if the device has been moved to a different location in the chain,
provided it has been given a unique name.

For details on channel configuration see chapter 3.3.
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2.6 Logs and Sessions

Different to other data logging products, LogWorks organizes the acquired data in logs and
sessions. A session is a contiguous data set. This means there is no interruption in the data
stream and all data points are spaced equally in time (81.92ms apart). Each time you start
logging, a new session is created and the session ends when the logging stream is stopped.

A log is a collection of sessions. In a typical qualifying race or tuning session multiple runs are
made, and each run is data logged. LogWorks conveniently organizes these runs into a common
log. The sessions in a log are numbered from 1 through x. Typically they are sequential in time,
starting with the oldest session as session 1 and so on. Each log can be stored in a separate file
on the computer. Each session can be renamed so it does reflect something more meaningful
than just a numbered sequence.

In addition each log contains the information on how to convert the digitized numbers (see
Logging engine data) into the original quantities. These so called channel settings apply to all
sessions in a log.

LogWorks distinguishes three different kinds of logs:

a) Real-time log

This is a log created by connecting a computer to the MTS log-chain and recording the real-time
data stream from the MTS devices to the computers hard drive. New sessions can be added at
any time by starting to record the serial stream.

Only one real-time log can be open at any time.

The current real-time input settings apply to the real-time log.

b) LM-1 log

This is a log created by downloading log data from the LM-1’s internal memory, but not yet stored
in a file. Only one LM-1 log can be open at any time.
The current real-time input settings apply to LM-1 log.

NOTE: The LM-1 has to be the first device in alog-chain. Therefore the only channels it
can see are its own AFR channel and the 5 channels on its Aux input. The LM-1 can NOT
record any other channels downstream in the log-chain.

c) File logs

File logs are data files created by LogWorks when saving a real-time log or a LM-1 log. Up to 30
such logs can be opened by LogWorks concurrently. LogWorks stores logs in either of two file
formats:

Log files (file extension .loQ)
Or
DIF files (file extension .dif)

The .log file format is native to LogWorks. It stores the original data in a very compact format and

also stores additional information like measurement points, filter parameters and all input settings.
This allows to change and manipulate the data later more conveniently than the DIF file format.
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The DIF file format is used to allow importing the log data into spreadsheet program like Microsoft
Excel.

The DIF format stores the data as manipulated by LogWorks and already converted into the real
engine quantities. Because of that, information can be lost when reloading a DIF file for further
manipulation.

The DIF format should only be used when the log data is to be processed by external software
like Excel.

NOTE:

LogWorks 2.0 LOG files (file extension .log) are different from log files created by
an earlier version of LogWorks. Although LogWorks 2.0 can read the earlier files,
an earlier version of LogWorks can’t read the new file format.

2.7 LogWorks Files

LogWorks uses the following files. These are installed in the same directory or folder where the
LogWorks program file (LogWorks.exe) is installed.

LogWorks.exe (the main LogWorks Program)

Mts.dll (the MTS serial protocol manager — includes plug-ins for LM-1, LC-1, and LMA-2)

Conversions.txt (text file containing formulas for unit conversions. See section x)

MathlibSl.txt (text file containing mathematical formulas in international units [MKS

system] for channel calculations)

e. MathlibUS.txt (text file containing mathematical formulas in US units [pounds, degF and
so on] for channel calculations)

f. ChartMathlib.txt (text file containing mathematical formulas for 3D-chart calculations.

g. Searchlib.txt (text file containing formulas for frequently used searches)

coop
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3 Using LogWorks

3.1 Starting up LogWorks

Connect OUT port of the last device in the Log-Chain to a free serial port on your computer and

start the LogWorks program. If an LM-1 is used, the LM-1 can either be currently operating in the
car or can be connected (running from its internal battery) to the computer. Real-time logging can
of course only be done when running the Log-Chain (can be as small as just an LM-1) in the car.

The following dialog box will appear:

Connect to LM-1

Select COM Part; Connect
IEDM 1 jv Dan't connect

ailk

r Cannect an thiz part in the future. [Iuit
[Dia nat ghow thig window again]

Select the serial port (COM Port) to which the Log-Chain is connected. Then press the Connect
button.

To quit here and don't start LogWorks press the Quit button.

If you do not wish to connect to the chain (or don’t have it connected), Press the “Don’t connect
button.

Check the “Connect on this port in the future” checkbox if you want to auto-connect on the
selected port always in the future (you can change that later on if you wish).

LogWorks can also be started by dragging one or more log files on the LogWorks icon (if you
installed one on the desktop). In this case the log files will be opened automatically.

A Make sure no other program (including LM Programmer or LM-1 Manager) is using
the selected serial port.
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3.2 The LogWorks Main Window

After this the main window of LogWorks, the LogWorks Monitor, appears:

ogWorks Monitor =10 x|
File Channels Dials Colors “Window  Preferences

This window is resizable by grabbing on the lower edge of the window. All gauges are grayed out
until:

a) LogWorks is connected to the Log Chain
b) A valid serial data stream is detected on the serial port
¢) The appropriate input is enabled.

When this happens the window might look like this:

*  LogWorks Monitor =10 x|
File Chanrels Dials Colors ‘Window  Preferences

e 4
|
Input 1 Input2

4

5 5
Input < Inputs

(%] 0
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3.2.1 Changing the preferences for units

Preferences

Lse international units (m,ka,degC...)
v Use US units (ft, |b, degF)

This menu allows you to set your preferences for unit calculations and for displaying channels. A
lot of calculations are different when US units vs. international units are used. To make it easier to
find the correct calculations, the math libraries are divided, so that the number of duplicate entries
is minimized.

3.2.2 Manipulating the gauges

LogWorks can display three different gauge types: Round, vertical bar and number.

. 9 47 = C— —

1 -- I

0 10 | . .-! !-!
RPM S

* 1000 LM _02 Throttle (5)

Round gauge (default) vertical bar number gauge

To change the size or position of a gauge, click on the gauge.
The gauge will be shown with a selection rectangle like this:

A gauge selected like this can be dragged in the window to any position. Grabbing the gauge with
the cursor at any of the corners allows you to resize the gauge.

Multiple gauges can be selected by holding down the Control key (Ctrl) while clicking on the next
gauge.

Changing gauge colors

The different colors used in the gauge display can be manipulated with the Colors menu. When
either of the items (like needle color) is selected, the following color dialog box will appear:

-19- Logworks2_Manual_1.1.doc



x

Calar Brighthess
100% =4

Click anywhere on the color circle to change the hue or saturation of the color. Saturation is how
‘intense’ the color is; hue is the color itself (red, yellow, green and so on). Grays have a saturation
of zero and are located in the center of the circle. The distance from the center is a measure of
the saturation. The slider on the right of the window determines the brightness of the color (in %
of the max brightness achievable for the selected hue and saturation).

Changing gauge depth position relative to other gauges

Use the Dials menu to change the gauge relative position and other positioning aspects:

Dials

Add new dial...
Edit dial.. .
Delete dial

Send to back
Bring to Front
Align horizontal
Align vertical
Equalize size

Send to back

Puts the gauge in the background behind other gauges if gauges overlap. This is useful when for
example using vertical bar gauges to show for example multiple AFR or EGT channels. By
positioning the bar gauges such that the next gauge to its left overlaps the gauges scale, a multi-
bar gauge can be constructed with minimum screen real-estate usage. In this case you would use
Send to back successively on the gauges from left to right. This way the rightmost gauge would
be furthest back.

-20- Logworks2_Manual_1.1.doc



Bring to front
This is the opposite of Send to back. It brings the gauge all the way in front of other gauges if
gauges overlap.

Align horizontal

If multiple gauges are selected, LogWorks calculates the average vertical center position of all
selected gauges and moves the selected gauges such that their centers align on the same
horizontal line positioned at the average vertical center position of the selected gauges.

Align vertical
Same as Align horizontal, but the selected gauges are aligned vertically.

Equalize Size
The average size of the selected gauges is calculated and the selected gauges are sized to the
average size.

Adding and Editing gauges

You can add as many gauges as you have logging channels. To add a new gauge (or change an
existing gauge) select Add new dial... or Edit dial... in the dials menu. The following dialog box
allows you to change the gauge type and the associated channel.

You can also specify if the gauge has a mark or a redline area at a specific scale location.

x

Style:

Showing Channel: |Lkd1_02

karkz and Redline area

= Maokdark Mak at 7 Bedine from

14.7 &FR

Cancel |

Note:
Double-clicking on a gauge also brings up this dialog box.

-21- Logworks2_Manual_1.1.doc



3.2.3 LogWorks Main File Menu

| File
Conneck, ., ZhElHL
v Auto-connect on start

Metw Realtime Log, .. ZhrH-M
[ew Triggered Realkime Log

Log Trigger Setup...

Download LM-1 Log... Ctrl+D
Open File Log... Ctrl+0
Import Input description...

Save Input description...

Reset LM-1 Log

Exit

Connect...
Allows the connection of Log Chain on the serial port if LogWorks was started without connecting.

Auto-connect on start
Allows auto connecting at LogWorks start to be switched off or on.

New Real-time Log...
Starts a new real-time log or brings the real-time log window to the front if it is already open.

New Triggered Realtime Log
Starts a Triggered Log. See section 2.4 Triggered Realtime Logs for details

Log Trigger Setup
See Section 2.4 Triggered Realtime Logs for details.

Download LM-1 Log...

Creates a new LM-1 log by downloading data internally logged in the LM-1. During downloading
the car may not be running (engine off) because the WB sensor’s heater is switched off during
downloads. After a download completes, the LM-1 is automatically restarted (heater runs again).

Open File Log...
Opens a saved log for further inspection and manipulation.

Import Input description...
Extracts the input settings data from an existing log file. Note that .dif files do not contain the
entire input description data.

Save Input description...
Saves the current input settings (see Configuring the Inputs) in a .log file. This log file will contain
only the input settings, no session data. Trying to open it as a file log results in an error.

Reset LM-1 Log
Resets the log memory in the LM-1. This works only in LM-1 firmware version 1.33b or later.
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3.2.4 LogWorks Channel Menu

Channels

Configure Channel r
Delete Channel r
Change Trace Colars. ..

Show Mixture as Lambda
v Show Mixture as AFR
Set Fuel type »

Configure Channel
Select the channel to configure. See Section 2.3 Manipulating the Channels for details.

Show Mixture as Lambda
The Mixture data from the Wideband Controllers in the Log-Chain is shown as Lambda.

Show Mixture as AFR
The Mixture data from the Wideband Controllers in the Log-Chain is shown as air-fuel-ratio
(AFR).

Delete Channel
Deletes the realtime channel

Set Fuel Type
This menu item is only important when the mixture data is shown as air-fuel-ratio. You can select
the fuel type independent of what the Wideband Controller settings are. Normally LogWorks uses

the device settings of the first Wideband controller in the Log Chain to calculate the air-fuel-ratio
settings.

3.2.5 LogWorks Main Window Menu

Use this menu to quickly switch between open logs.
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3.3 Manipulating the Channels

3.3.1 Configuring the Channels

The Configure Menu of the main window allows configuring the LM-1 inputs. The AFR/Lambda
input can’t be configured. You can only switch it between displaying Lambda or AFR. To
configure an input, select the appropriate input from the Configure menu or double-click on the
appropriate instrument. The following dialog box appears:

x
_ [rput M ame: IDut_l,l_n:_l,u:IE:I @

— Input Type
Li-1 Air/Fuel Batio Meter
|nput Maode @
=) LM-1
Input 3 | Duty Cycle [DWELL) =]
R Input Rahge

I Pozitive j
Accessany

LM&-3 fuBox Ry

— Input Interpretation

IInit of meazurement @ . @
Q.0 4 equivalent to [0.00 Walt

[% -] | | :
and I'IEIEI.U x equivalent ko |5-':“:| Walt

¥ Ewxpand to 0.5y @

@ Irvvert Scale | £~ Limit to programmed range
Custom Lookup T able | [elete Table |® Cancel | k. I

This dialog box contains up to 11 fields.

Field 1.

In field one you can specify a hame for the input for easy identification. The left side of this field
shows a colored box. This color is the trace color of this input in the logs.

Use a unique name.

Only letters, numbers and the underline character _ are allowed in an input name.
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Field 2.
Select or enter the unit to be used for that channel. This drop-down list shows all units that are
preprogrammed into LogWorks. For details about using units and unit conversions see chapter 8.

Units typically belong to a unit family. A unit family consists of different units for the same
measured quantity. For example you can measure pressure in PSI, inHg, kPascal and so on.
Conversion formulas describe how to convert between different units of the same family. In the
drop-down list the units belonging to the same family as the current unit are shown in bold face.
When converting between absolute pressure and gauge pressure LogWorks will ask you to enter
the current atmospheric air pressure:

Atmospheric Pressure

Please enter current atmozpheric
prezzure in inHg or millibar

IEEI.EIE

You can enter this in either in inches of mercury (inHg) or millibar. LogWorks decides from the
number entered which unit is used. This is asked only once after LogWorks has started and will
not be asked again if that conversion is executed again. For details see chapter 8.1.2.

Field 3,4 and 5

Specify two voltages (0 and 5V in the above example) in field 4 and the equivalent measurement
guantity ( 0 and 101.3 kPa respectively in the example). If voltages different than 0 and 5V are
specified, the range will be automatically expanded to 0..5V if the radio button “Expand to 0..5V”
in Field 5 is selected, even if the sensor is not capable to produce 0..5V (the measured signal will
stay within the range the sensor produces).

If the “Limit to programmed range” radio button is selected, the input is limited to the programmed
range in field 3. Input values outside the range will be clipped to the entered range.

To easily enter the correct voltage values when LogWorks is connected realtime to a Logchain,
you can also right-click on one of the voltage fields.

TPS Example:

To calibrate a TPS sensor, connect the sensor to for example an LMA-2 or LMA-3, switch the
ignition on but don't start the car. Enter % as the unit and enter 0 in the upper box of field 3. Then
right-click on the upper box of field 4. A menu will show up that allows you to paste in the current
voltage of the TPS sensor into the upper box of field 4.

Next enter 100 in the lower box of field 3, depress the gas pedal fully and right-click in the lower
box of field 4. Paste in the full throttle voltage.

Field 6.

Clicking on the “Invert Scale” exchanges the upper and lower boxes of field 3. This is useful for
example for duty-cycle measurement. Normally the LMA-3 will measure positive duty cycle. This
means that 100% duty cycle happens when the input is at full voltage and 0% when the input is a
OVolt. A typical fuel injector and also ignition points show full voltage when off and OV when on.
This is a negative duty cycle. By inverting the scale you can measure this duty cycle correctly
where 0V means 100% and full voltage means 0%.

Field 7.
Adds or deletes custom lookup tables. See chapter 3.3.2 for details
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Field 8.

This field shows the name, type and icon of the device where this input is from. If a device allows
the connection of optional accessories, the accessory selected is also shown. The example
shows a LMA-3 Auxbox connected to the LM-1.

Field 9.

This indicates the input mode selected for this input, dependent on the device. LogWorks
interrogates all devices connected to the serial LogChain during connection and downloads their
settings. If the settings have changed since the last time LogWorks started, LogWorks will change
the current input to the current settings of the input, using defaults for the unit and range.

If a device is connected to the Aux-In port of the LM-1, it can’t be interrogated by LogWorks. In
this case you have to manually select the function and, if necessary, fill out the fields for range
and unit. See the manual for the appropriate device for details.

Field 10.
Allows you to select sub-functions for the selected main function as selected in field 9. This field
will only be shown when sub-functions are selectable.

Field 11.

This field is present only for devices that allow connection of accessory devices. For example the
LM-1 allows to select LMA-3 and LMA-2 or home-made connections. Select the appropriate
device as accessory.

Note:

LogWorks will maintain the channel configuration for each device, even if the device has
been moved to a different position in the LogChain. This is NOT true for display devices
like the XD-1. The XD-1 is sensitive to the position of it's programmed input in the
LogChain. This means that if you moved for example an LMA-3 from the first position in
the LogChain to the second position, and have the XD-1 programmed to display or use
(hold or waring) an XD-1 channel, you need to reprogram the XD-1.

3.3.2 Custom Input Lookup Tables

Many sensors used in cars have a non-linear response curve. This means that their output
voltage does not follow the measured quantity linearly but with some sensor dependent curve.
LogWorks allows you to enter points of that sensor curve (as many as 1024, the more, the better)
to convert the sensor output voltage back into the measured quantity directly. LogWorks
interpolates the sensor measurements between entered points.

Press the Load/Edit Table button in field 7, and you will be presented with the following dialog
box:
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Bl Input Lookup Table x|

PsI Yalt
147 0.aa0
294 5.000

Shift Table Vol

IEI.EIEIEI LDadNewl Eancell (] I

Double click on any field in the table to modify it. Click on a field to select it. To delete an entry,
select it and hit the delete key.

If you make changes by editing, click anywhere in the table to make the changes
permanent.

You can import a new lookup table from a text file (extension .txt) or a DIF file created by a
spreadsheet program (extension .dif). A text table must have two columns, separated by spaces
or tabs.

The first line contains in the left column the unit of the measured quantity (PSI in our example).
The right column, first line must contain the word “Volt”.

Underneath that first line listed are the individual equivalents of the lookup table. Left column
contains the measured quantity and the right the equivalent voltage.

Note:

The slider on the left of the window shifts the entire table voltages up or down to
compensate for ground differences between the MTS device ground and the
measurement sensor. This should NOT be used with the LMA-3. It automatically
compensates for ground differences when connecting the CHx- input to the sensor’s
ground.

The following is an example of an input lookup table:

PSI Volt
-14.7 0.1
-10.0 1.2
0 2.1
5 2.8
15 4
29.4 4.9
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A DIF file must be organized similarly. The top left entry in the spreadsheet (field A1) must
contain the measured unit. The second entry (field B1) MUST contain the word “Volt”. The rest of
the ‘A’ column contains the measured quantity equivalents and the rest of the ‘B’ column contains
the equivalent voltages.

When loading the table LogWorks sorts it in ascending order by voltage. LogWorks then creates
a custom lookup table for all 1024 possible input values by interpolating between table points
using what's called cubic splines (Not the right place here to explain what they are). The table
must be monotone rising or falling. If the difference between the second quantity and the first
guantity is positive, the quantities must be always rising (third bigger than second and so on. If
the difference is negative, the quantities must be always falling (third smaller than second and so
on). If this were not the case, the same voltage could mean different measured quantities.

Example of monotone lookup table (x in PSI, y in Volt):

(o))

an

()

-20 -10 0 10 20 30 40
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An example of a wrong table:

JAN
A\

1 \
=+ g
/ 05

oo

-20 -10 0 10 20 30 40

Note that 2.1 V could either mean 0 PSI or 15 PSI.

Notel:

Different than the custom setting in Field 3. and 4. of the Input Settings dialog box, the
lookup table will NOT be automatically expanded to 0..5V. Instead the resulting log is
clipped to the minimum and maximum of the table entries.

Note2:

If this dialog box was started from the LogWorks main window, double-clicking on one
of the voltage fields, then right clicking on it will show a menu that allows you to paste
the current input voltage of this input.
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3.4 Triggered Realtime Logs

Sometimes it is convenient to start/stop a log not by hand, but automatically when certain
conditions are met.

The New Triggered Realtime Log and Log Trigger Setup menu items in the Main window file
menu allow you to do that.

Examples are in drag racing, where a run needs to be logged, but there’s no time to select the
appropriate menu while waiting in the staging area. Another use is to track down random
problems. The trigger condition can be set up to start a session when the problem condition
happens. It can then also pre-record a programmable time before the condition happened so one
can see what led up to the problem without searching through long sessions. Pre-record includes
the programmed number of seconds of data before the start condition happened. When waiting
for a trigger LogWorks continuously records data, but keeps only the last pre-record seconds and
throws older data away. When the trigger happens, the current data buffer is first inserted in the
session, followed by the recording.

When selecting the Log Trigger Setup menu item the following dialog box will show up:

Realtime Log Trigger X|

Channel Comparison  and/or

— Log Trigger Start when
[Thrattle > 50) AND [RPK > 3000)

and condition perzists for IEI.EIEI sec.  Pre-Record: IEEI 2EC.

— Log stops when

and condition persists fu:ur:IIJ_EIEI IEC, P'u:ust-Fieu:u:urd:IEl.ElEl FEC.
Cancel | k. I

3.4.1 Trigger Start Condition Setup

In the Log Trigger Start field you enter the session start condition. In the above example the
session starts when the Throttle channel indicates more than 50% and RPMs are greater than
3000. Use parenthesis () liberally to indicate conditions.

DO NOT ENTER THE UNITS in the condition equations.
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For example DO NOT enter: Throttle > 50%. LogWorks knows the units already from the channel
name (Throttle in this case) and does not need to be told.

The persist field allows you to specify a length of time for the condition to persist before the
recording is started. This allows eliminating false starts due to for example spikes or glitches.

The Pre-Record field allows you to set a time that LogWorks records before the start condition
happened. If set to 60 seconds as in the example, LogWorks will include in the session the last
60 seconds before the start condition happened. Pre-Record times of up to 300 seconds can be
programmed. If a persist time is used, the persist time is included in the pre-record time.

3.4.2 Trigger Stop Condition Setup

Once a recording session has started, it will only stop if the following things happen:

a. The user stops recording with the stop button in the Log Window
b. A stop recording condition has been specified and the condition happened.

In the Log Trigger Stop field you can specify a stop condition. This is done exactly the same way
as for a start condition, including the capability to program a persistence time to avoid stopping a
log on short glitches and spikes.

In the post-record field you can specify also a time (up to 300 seconds) for which LogWorks will
continue to record after the stop condition happened.
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4 Working with Logs and Sessions

4.1 The Log Window

I C\...\Release\Autobahn.log - Session 1 - |EI|£|
File Edit Sessions Channels Tools View @
|':{T_"] I = | & B @ Session length: 3719 zec
S 18.27 sec
N T 1277 soc_ [
- @ 2.57 A
- o o] E380 RPM
o N -
g_ o =] 99.8 %
Ej‘_ o o 5.90 5E\.:_
r oo o 12.28 AFA
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oy B 98 .4 %
=R S =
2 o N
= —
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—_— -0
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The Log window can be resized to any size. It is divided into different areas and has three
different panes:

The scale pane (3) shows the vertical scale, the graph pane (6) shows the time traces for the
channels and the measurement pane (5) shows the values at the cursor position if the cursor is in
the graph pane. Here’s a short description of the parts of the Log Window.

1. Menu area
Contains the Log menus.

2. Tool area.
Allows selecting the various tools and functions to manipulate the log.

3. Vertical scale Pane
Shows the vertical scale of the graph for the various channels.

4. Pane Dividers (Mullions)
Grab the pane dividers with the cursor to resize the panes.

5. Measurement pane

Shows the current values of channels under the cursor if the cursor is moved in the graph pane.
Moving the cursor over a text note icon shows the content of the text note in the pane.
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If an overlay session is used, the overlay values are shown in parenthesis () and italics like this:
(overlay)

6. Graph Pane

Shows the graphs of the active channels color coded. Moving the cursor over a channel
highlights the channel (trace shown in double thickness). Right-clicking on the highlighted
channel brings up a menu to manipulate different aspects of the channel. Leaving the cursor on
the highlighted channel for a second will show the name of the channel.

7. Time scale area

8. Note area
In this area notes can be placed to comment events at that point in the session. Notes are

indicated by an Icon . Moving the cursor over a note will show the note contents in the
Measurement Pane. Double-click on the note Icon to edit the note text. You can also move the
note in the note area by clicking and dragging.

Some MTS logging devices can record audio comments while logging. If an audio comment is

inserted, an audio note icon E] will be shown at the audio comment point. Double-click on the
icon to play the audio comment.

To delete a note, drag the note outside the note area.

9. Text Note
Indicates a text note at that point.

10. Measurement point

Any number of measurement points can be inserted in a graph. The measurement points scroll
with the graph. A measurement point shows the values of all active inputs at that particular point
in time.

11. Session length info
Shows the total length of the session.

4.2 Log Window Tools

Select the tool by clicking on it. You can also switch between tools using a keyboard shortcut.

4.2.1 Hand Tool (Shortcut Ctrl-H) ul

Scroll the graph left and right. If a channel trace is vertically magnified (see magnification tools)
also scrolls the trace up or down. To scroll, click in the graph (left mouse button) and drag the
graph left or right.

If a real-time session is currently recording, the graph will automatically scroll to show the latest
data. Scrolling with the hand-tool or the horizontal scroll bar to an earlier time in the recording will
stop the auto scrolling. To restart auto scrolling, scroll the graph to the rightmost end.
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4.2.2 Overlay scroll tool @

When an overlay is pasted onto a session, this tool moves the overlay relative to the underlying
graph. To scroll, click in the graph (left mouse button) and drag the overlay left or right.

4.2.3 Selection Tool e

Allows selecting a portion of a session. To select a portion, click in the graph (left mouse button)
and drag the mouse left or right. Whenever you click (without any other keys held down), the
current selection is removed. Holding down the shift key while clicking extends the selection from
the first click to the new click.

Holding down the Ctrl key while clicking allows selecting multiple areas without removing the
previous selection.

4.2.4 Magnification Tools )

The &, tool is used to magnify, the S tool is used to reduce a magnification. To magnify or
reduce a channel vertically, click on the channel trace with the tool.
To magnify/reduce the time scale, click on the time scale with the tool. Holding down the Ctrl-key

will select the opposite of the current tool. For example if you selected the magnify & tool it will
change into the reduce S and vice versa.

4.2.5 Measurement tool (Shortcut Ctrl-M) &

Use this tool to add measurement points in the graph as shown in item 10 of the window.

Click anywhere in the graph to add a measurement point. Click in the measurement window
(rectangular area showing the measurement results) to remove a measurement point. Click and
drag to fine-position a measurement point. Any number of measurement points can be added.
When holding down the Ctrl-key while releasing the mouse button, the measurement point is
considered temporary and will be removed.

Select this tool and click anywhere in the note area (area 8 in the window) to place a new note
there. Once placed, a dialog box will show up that allows you to enter the text for the note.
To delete a note, drag it outside the note area.

4.2.7 Real-time Logging Start button (Shortcut Ctrl-N) |

This button is only active in the real-time session window. Clicking this button starts a new real-
time session.

4.2.8 Stop button (Shortcut Ctrl-Spacebar) Ll

Clicking this button stops recording a real-time session.
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4.3 Manipulating the vertical scale pane

If a channel trace is vertically magnified, you can scroll that trace up or down by clicking and
dragging on the scale for that trace.

Right click on a vertical scale for a trace and the following menu will show up:

Maove LM1_02 scale to graph
Move LM1_02 scale right
Move LM1_02 scale left

Hide LM1_02

With this menu you can hide a trace and manipulate the order of the channel scales in the vertical
scale pane.

The grid in the graph pane is adjusted to the scale that is next to the graph pane.

4.4 Manipulating traces in the graph pane

Right-click on a trace in the graph pane and the following menu will show up:

Hide R.PM

Zoom in RPM
Zoom out RPM
Smooth RPM...
Set Grid to RFM

Configure RPM...
Delete RPM

4.4.1 Hide Channel

Hides the channel trace and its associated vertical scale. The measurement pane will still show
the values of the hidden channel though.

4.4.2 Zoom in Channel

Increases the vertical magnification of the channel

4.4.3 Zoom out Channel
Decreases the vertical magnification of a channel
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4.4.4 Smooth channel
When selected, the following dialog box will appear:

X
Smnthing:é -—J— 50.41 20

This allows you to ‘smooth’ a channel. The smoothing slider allows smoothing a trace by
replacing each data point with the running average of its neighbors and itself. The position of the
slider determines how many of the neighbors are included in the running average (0 to 32
neighbors on each side).

Smoothing can be used to better see trends and is necessary for some calculations (specially
those involving calculating slopes). Smoothing should NOT be used to get rid of excessive noise
in a channel, for example spikes caused by ignition misses. Because smoothing is an averaging
operation, the lean-spikes caused by ign. misses would be included in the AFR values and would
bias them towards leaner values.

4.45 Set Grid to channel

Can be used to set the graph-pane grid to the selected channel without moving the vertical scale
next to the graph.

4.4.6 Configure channel

Brings up the channel configuration dialog box as described in Section 3.3 Configuring the
channels.

Input configuration changes performed in the real-time log window also apply to the LogWorks
main window and vice versa. The same is true for the LM-1 log window.

File log input changes only affect the current file log.

4.4.7 Delete channel
Deletes the channel trace from all sessions in the log.
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4.5 Log Window File Menu
| File

Record new Session Zhr{H-F
Record new Triggered Session

Stop Recording Chrl+space
Flayback. ..

Save... Cirl+5
Save As...

Save current session only...

Print... Cirl+P
Close

45.1 Record new Session
Starts a real-time session. Same as Real-time Session Start button.

4.5.2 Record new Triggered Session

Starts waiting for a trigger to start a new triggered session. To stop while waiting for a trigger,
select Stop Recording.

4.5.3 Stop Recording

Stops the current recording session. Same as the Stop Recording button. You can also stop while
waiting for a trigger to interrupt the wait.

4.5.4 Playback...
Brings up the Play Window.

M C:\...\Release\Autobahn.log-1 — | I:Ilil

Dials Playback speed
> MmO

12 \l{l 10
Throttle RPM

x 10 % %1000
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The gauges in the playback window can be manipulated the same way as described in section
2.2.2 Manipulating the gauges. The position, type and colors of the gauges and of the playback
window is saved in the log file when log file is saved.

In addition you can play, single-step forward and back and loop on an area. If areas in a session
are selected, only the selected areas are played. When playing back while a 3D chart/graph is
open (see section 5) the play position is also indicated in the chart/graph.

455 Save...

Saves the log into a log file. Either as .log or as .dif file. .dif files can be opened by many
programs, including Excel. To open a .dif file in Excel, select “Data Interchange Format” as the
file format in Excel.

45.6 Save As...

Saves the log under a different file name.

4.5.7 Save current session only...

With this menu item you can save the currently displayed session in a separate log file (or .dif
file).

45.8 Print...

Prints the log or current session. A print dialog box like below appears:
I

— Printer
Properties |

Marme;

Statuz: Ready
Type: HF Desgkjet 3740 Seres

Wihere:
— Print range — Copies
" Al Sessions
- : Murnber of copies: |'| E:
" Cumrent Session =2
T F 1] to: |38 SRCE. E
L I - ™| Callate
= Cument ‘Window
I Print Motes — Show vertical zcales
— Presentation £ On first page only
™| Espanded Timescale as shown " On all pages
[T Expanded vertical scales az shown

| k. I Cancel

This dialog is divided into four sections:
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In the ‘Printer’ section select the printer to use. Usually you do not need to touch this section.

The ‘Print range’ section allows you to select the time range you want to print. Also selects
whether you want to print the content of all the text notes as well.

The ‘Presentation’ section allows you to select if you want to show the time-scale or vertical
scales for each input expanded as in the window or at their normal 1:1 scale.

The ‘Show vertical scales’ section allows you to select if you want to show the vertical scales on

the left of the graph on every page or only on the first one. Showing it only on the first page allows
you to glue the pages of a long session together as a strip-chart.

459 Close

Closes the log window.
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4.6 Log Window Edit Menu

Edit

oy Zhrl T
Paste as Oyetlay (o
Fasbe as new Session Imis
Remoye Oryerlay e
Autoselect... Ctrl+F
Search Library...

Go to next selection Cirl+3
Select whole Session CTrl+4
[elete Selection el
Invert Selection

Invert Selection in all Sessions

4.6.1 Copy

Copies a selection (see Selection Tool) into the LogWorks internal clipboard.

4.6.2 Paste as Overlay

Pastes the clipboard content on top of the current session as overlay. The traces of the overlay
are shown as dashed instead if solid as in the example below:

7070 RPM
(7330 RFM)
100.5 %
{97.3 55) '
gt i L

Using the overlay scroll tool you can move the overlay left and right. If a measurement point
overlaps an overlay trace, the overlay measurements at this point are shown in brackets () and
italic. The hand tool or horizontal scroll bar moves underlying graph and overlay together.
Overlays are not saved with a log.

4.6.3 Paste as new session

You can only paste a session or part of a session into an existing log from another log. The input
definitions of the source and destination logs have to match.
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4.6.4 Remove Overlay

Removes the overlay.

4.6.5 Autoselect...

Autoselect is a very powerful tool to select areas of interest in a session. Selecting this item
brings up the following dialog box:

x

Channel Comparison  andfor

Selection Term
[AFR » 14. 7] AND [Thrattle > BOJAND [MAF =

18]

|ze:

= [equal] ¥ [not egual]

» [greater than] ¢ [lesz than]
»=[greater or equal] <= [lesz ar equal]
AMND and OR

Add to Search Libran | Search I

In the window of this dialog box you can specify search terms like “AFR > 14.7” and so on. You
can then connect these terms with ‘AND’ or ‘OR’. LogWorks will process the entire session and
select those areas which satisfy the search criteria. In the above example all lean spots leaner

than 14.7 AFR are selected where the engine is under boost and the throttle position is bigger

than 60%.

Do not specify a unit (like % after 60% or PSI after 0 PSI).

Note that the input names are case sensitive. Afr would be different than AFR. Make sure you
type the input name correctly. Click on the ‘Add to Search Library’ button to add the search term
to a search library. The search library holds frequently used searches. When clicking the button a
dialog will show up that will allow you to specify the name, category and comment for the library
entry. See section 7 LogWorks Libraries for details.

4.6.6 Search Library

Brings up a list of stored searches. See section 7 LogWorks Libraries for details.
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4.6.7 Go to next selection

This menu item (equivalent to a search function) jumps directly to the beginning of the next
selection created by for example the Autoselect function. It also puts a temporary measurement
point at that point.

4.6.8 Select whole session

Equivalent to the select all function of other programs. Selects the entire session.

4.6.9 Delete Selection

Deletes the selected area from a session.

Note:

Only areas at the beginning or end of a session can be deleted. Deleting in the middle
would cause a non-contiguous data area and is therefore not allowed.

4.6.10 Invert Selection

All areas in the session that are selected will be unselected. All areas that were unselected, will
be selected.

46.11 Invert Selection in all sessions

Same as Invert Selection above, but the process will be applied to all sessions in the log.
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4.7 Log Window Session Menu

Sessions

Show Time in Seconds only

Show Session Info Ctrl+I
Delete current Session Shift+Del

v Session 1
Session 2
Session 3
Session 4
Session 5

4.7.1 Show Time in Seconds only

Normally the time in the time scale are is shown in minutes and seconds. With this menu item the
time can be shown alternatively in seconds only.

4.7.2 Show Session Info

Brings up this dialog box that shows information about the current session:

x

Sezsion Name: IS egzion 1

Sezsion Recorded: I B/ 242005

e L

|1n:45:24 Ak

Dwration: 3719 sec

Comments

| =

Session name,

Session length (in minutes and seconds),
Record start time and date,

And a comment added to a session.

If the record time and date is unknown (for example for a session recorded in an LM-1), the
current time and date is shown. You can change the time and date for a session by editing the
appropriate field.
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4.7.3 Delete current session

Deletes the current session from the log. If only one session is left, it cannot be deleted (logs
can’'t be empty).

4.7.4 Session selection

Select which session you want to view/manipulate.
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4.8 Log Window Channel Menu
Channels

Set Grid to

Show Hide Channel
Smooth Channel
Configure Channel

Delete Channel
Recalculate Math channels
Change Trace Colors. ..

- T v w v

Apply default smoothing
Save current smoothing as default

v Show Mixture as AFR.
Show Mixture as Lambda
Set Fuel type »

4.8.1 Set Grid to

This submenu allows you to change the graph pane grid to the selected channel without moving
the vertical scale next to the graph pane.

4.8.2 Show/Hide Channel

Hides/Shows a channel trace and scale. Same as described in section 2.8.1 Hide Channel.

4.8.3 Smooth Channel

Same as described in section 2.8.4 Smooth Channel.

4.8.4 Configure Channel

Brings up the channel configuration dialog box as described in Section 2.3.1 Configuring the
channels for the selected channel.

Input configuration changes performed in the real-time log window also apply to the LogWorks
main window and vice versa. The same is true for the LM-1 log window.

File log input changes only affect the current file log.

4.8.5 Delete Channel

Deletes the channel trace from all sessions in the log.
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4.8.6 Recalculate Math Channels

Recalculates all new channel traces created with the Math trace calculator. This might be
necessary if various aspects like smoothing, or the configuration of channels used to calculate the
Math traces changed. See chapter 6: Math Trace Calculator for details about calculated
channels.

4.8.7 Change Trace colors

Brings up a dialog box to change the colors of the channel traces:

x

Channel/Trace colors. Click to zelect Channel Color Brightness
[ e
RPM Throttle =4

| I | | | Carcel_|

On the left side of the dialog box, select the channel whose color needs to be changed.

Click anywhere on the color circle to change the hue or saturation of the color. Saturation is how
‘intense’ the color is. Gray scale colors have a saturation of zero and are located in the center of
the circle. The distance from the center is a measure of the saturation. The slider on the right of
the window determines the brightness of the color (in % of the max brightness achievable for the
selected hue and saturation).

4.8.8 Apply default smoothing

If the current smoothing values for a channels are saved, this applies the saved smoothing values
to all channels in the session.

4.8.9 Save current smoothing as default

Saves to smoothing values for all channels of the current session as default values to be used
later.

4.8.10 Show Mixture as AFR or Lambda

Allows you how to show the Mixture channels in either AFR or Lambda.
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4.8.11 Set Fuel Type

Allows you to manipulate the AFR multiplier (stochiometric ratio of fuel used) for all Mixture
channels in the log. This has only an effect if the mixture for the mixture channels (WB —-02
channels) is shown as AFR.
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4.9 Log Window Tools Menu
Tools

Hand Tool Ctrl+H
Selection Tool

v Measure Tool Ctrl-+M
Scroll Qverlay Alt+H

Delete Measurements

Formula Calculator. ..
Formula Collection. ..

4.9.1 Tool Selections

The Hand Tool, Selection Tool, Measure Tool and Scroll Overlay selections are the same as
described in the Log Window Tools chapter.

4.9.2 Delete Measurements

Deletes all measurement points in the current session.

4.9.3 Formula Calculator

Brings up the trace calculator window. See Section 6 Math Calculator for details.

4.9.4 Formula Collection

Brings up the trace calculator Library. See section 7 LogWorks Libraries for details on how to use
the various libraries LogWorks uses.
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4.10 Log Window View Menu

4.10.1

View
Cascade Windows Cirl+T

Mew X-Y Plot... Ctrl+Y
%=y Blats

Statistics. ..

Mew Chart. ..
View Chart. ..

Cascade Windows

This item causes all auxiliary views of the session (Statistics Window or X-Y Plot Window, see
below) to be stacked in the top left corner of your screen.

4.10.2

New X-Y Plot...

This opens a new X-Y Plot window. An X-Y plot window shows the data of any two inputs in a
two-dimensional graph like this:

Il Log File XYPlot (RPM,LM1_02)

¥-awis  Y-axis Min/Max

beazured Time: B.06 zec

=10l x|

2o

TR

136 1

LM1_02 (AFR)
13.2%
.

&
&
S
%

28
o
o

128

)
BF =100

In this case the Y-axis is AFR and the X-axis is RPM. You can select any two inputs as either of
the X or Y axis. If nothing in the graph is selected, the X-Y Plot represents the data of the entire
session. If a part of the session is selected (Selection Tool), only the data of the selected areas is
represented. If overlays are in the selected area, the overlay data points are shown as
rectangles, the original as crosses.
For example if you are only interested in the AFR over RPM curve for wide open throttle (WOT),
you can either hand-select these areas or use the Autoselect tool if you have a throttle position
input connected to the LM-1.
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As shown above the individual data points are shown as small "x"s. Clicking the ‘----* button
shows the data points connected with lines as in this:

I Log File XYPlot (RPM,LM1_02) _ |0l x|

¥-awis  Y-axis Min/Max
tMeazured Time: 506 zec

1.4

140

132 136

LT _02 (AFR)

)
L

128

21 24 27 W 33 3/ 39
| - FPk =100
Print... | [T Ol S—

The X and Y axis are automatically scaled to the range of input values for the respective axis.
Manipulating the session data with the smoothing filter, changing selection or adding/deleting
measurement points will be automatically represented in the X-Y Plot.

Multiple channels can be shown at the same time in the plot. The Y-axis menu allows selecting
which channels are shown. In addition the Min and Max points for each of the channels shown on
the Y axis can be indicated as in this example:

I Log File X¥Plot (RPM,LM1_03Z) Ol x|

¥-axis  Y-axis  MinMax
beazured Time: 29.33 zec

E_ :"I ”:..-\_..= :-'_ :'
=, ! Max forque 135.6 I
'y i = T
1- - =Ty Max power 168,
T 1 LELLN Max power 164
= = mf 90N ;
]
a. = .
=
w- ]
= it}
= - L
= |
=2 T
= = <L W@
- L. n
kT
- R
-
L —
2 Tz a 3
a 2 Sof R
2 3 4 5 B 7 8

. | ............... . FPt =1000
Frint... () sendsete w1 :

The Min/Max values of the overlay channels are shown in italic font.
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4.10.3 X-Y Plots

This submenu lists all open X-Y Plot windows and allows you to quickly bring one to the top.

4.10.4 Statistics...

This submenu opens a statistics window for the selected input. A statistics window looks like this:

Bl LogFile Stats (AFR) Xl

Frequency of occurance

12 13 14 15 16 17 18 13 20 21 22
[&FR]

kMeazured Time:  33.75 zec
Average: 15

Maw: 22

Min: 12

This window shows how often a certain input value happened during a session or partial session.
If nothing in the graph is selected, the Statistics window represents the data of the entire session.
If a part of the session is selected (Selection Tool), only the data of the selected areas is
represented.

The vertical axis is automatically scaled relative to the highest occurrence. The horizontal axis is
automatically scaled to the range of the input with the session or selection.

In addition the window shows how many data points (time) are represented, the average of the
selected data and the minimum and maximum points in the selected data range or entire session.

Manipulating the session data with the smoothing filter, changing selection or adding/deleting
measurement points will be automatically represented in the statistics.
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4105 New Chart...

With this item a new 3D chart can be specified. A 3D chart is a table (or graph) that shows the
contents of a channel as dependent on two other channels as in this example:

JRI=TEY
File Edit Sessions Table View Graphic  Colors
Awerage | Std Devl MHumber ptsl b I bir I
LM1_C2 Throtile (%) RPM  LM1_02 [AFR) REM @ 200
(AFR) 0 [4000 [2000 [ 2000 [ 4000 [ 5000 [e000 | 7000 | 2000 [ 9000 [||Throttle & 1
. 0.0 1501 22042237 [22.37 (2212 [19.80 |18.28 1235 || oo
- 10.0 14.93 [16.63 1220 [14.59 1428 (] —
20 20.0 1497 12.02 [14.08 [11.72 | |5td Dav
30.0 1424 1222 1458|2024 [|] —
- 200 14.39 13.41 [14.44 |15.27 ||[umber pts
16 50.0 14,87 1475 [15.02 [14.88 r-.-1:x
80.0 14.08 1481 [12.57 [1s87 [1500(|] _
L 70.0 12868 [14.32 1688 [17.268 [14.47 || lmin
12 20.0 14.41 [14 52 18.98 [13.84 [19.02 [1582(|] —
90.0 12.71 [12.97 12.92 [14.01 [15.34 [14.39
- 100.0 1284 [12.82 1262 [12.52 1214 128 1277 [12.60 [12.91
g 110.0
120.0
1 | e e

This example shows average AFR over throttle position and RPM.

The fuel map or ignition map of an electronic fuel injection system is a typical example for such a
map.

For further details see chapter 4. 3D charts and graphs

When this menu item is selected, the following dialog box will show up:
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— Horizontal Awxis
Channel IHF'M j
Frarm ID b I'IEIEIEIIJ =1
Mumber of steps |11 [max 128
—YWertical Axiz
Chanrel IThru:uttIe j
Fram |n.n ta |12|1n %
Mumber of steps I'I 3 [ax 128
— Chart Cantent
Channel ILM1_|:|2 j

This allows you to select the x- and y channels, the content channel and the range and number of
steps for the initial chart settings. Don't fret on the number of channels and range though. Once
the chart is created, you can always manipulate the spacing and number of the columns and rows
of the chart.

4.10.6 View Chart...

You can select from the last four chart settings used (also up to four charts can be open at the
same time). LogWorks stores the chart settings in the log file when the log file is saved.
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5 3D charts and graphs

3D charts are tables or graphs showing the dependency of a selected channel (content channel)
in relation to two independent other channels.

The independent channels (x and y axis) are divided into variably sized sections. The values of
the content channel are sorted into ‘bins’ dependent on the content of the x-y channels. The
average value, standard deviation, number of datapoints contributing and the max and min for
each bin are calculated.

5.1 The 3D chart window

Il LM1_02 Chart owver RPM/Throttle _ 10l x|
File Edit Sessions Table View Graphic Colors o @
Average I Std DEVI MHurmber ptsl b ax I kin I fuel_map target_afrf"ﬂ
LM1_o2 Throttle (3%) RPM  LM1_C2 [AFR) REM @ 2000
[AFR) 0 [1000 [2000 [2000 [ 4000 [ 5000 [ 6000 | 7000 [ 2000 [ =000 [1000 [Throttl= @ 70.0
0.0 15.08 22,04 |22.37 |22.37 [22.20 [19.54 [15.34 [12.35 —
27 AvErage
10.0 14,83 [16.63 12.20 [14.88 [14.26 14 47
20 @ 200 14.08 13.02 [14.08 [11.72) Std Dev
18 30.0 14.94 1222 [12.87[20.3 211
40.0 14.42 12,47 | 14.44 | 15 3oy N umMESr pts
- 50.0 1487 Ny 1278 15,20 [12 80 O/ 2
1(_ | ST 4 N 4 ¥ A= r-,|3,.-\
80.0 14,09 14.81 [12.57 [15.67 [15.00 1507 @
12 70.0 13.46 [14.32 1666 |15.73 [14.47 Min
. 50.0 14.41 [14.52 15.98 [12.84 [19.02 [15.82 12.86
30.0 12.62 [12.97 12,82 [14.01[15.69 [14.28 fuel_map
& 100.0 1285 [12.82 [12.82 [12.62 [12.14 [12.88 [12.77 [12.69 [12.81 -
target_afr
1| | Ll

The Chart window can be resized to any size. It is divided into different areas and has three
different panes:

The colorizing pane (3) allows selecting the color range if colorizing is selected, the chart/graph
pane (4) shows the values of the selected sub-chart and the measurement pane (5) shows the
values at the point of the cursor when the cursor is in the chart/graph pane. Here’s a short
description of the parts of the Chart Window.

1. Menu area
Contains the Chart menus.

2. Chart Selection Tabs
Allows switching between displaying the sub-charts. Just click on the tab. The standard sub-
charts that are always generated are:

a. Average (average value for the bin)

b. Standard Deviation (statistical standard deviation for the bin). A bin where the standard

deviation can’t be calculated (Number of datapoints less than 2) will be shown as ---.

c. Number pts: Number of datapoints in that bin

d. Max: the maximum value of all datapoints in the bin

e. Min: the minimum value of all datapoints in the bin
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In addition the example window shows two user sub-charts: fuel_map and target_afr. More on
that later.

3. Colorizing pane
Allows colorizing the chart according to different values. See 5.4 Colorizing charts and graphs for
details

4. Chart/Graph pane
Shows the values of the bins of the selected sub-chart.

5. Measurement pane
Shows the values of all sub-charts of the bin over which the cursor currently is. Resize the
measurement pane by grabbing its left border.

6. Chart bins

5.2 Selecting data to base the chart on

In the Sessions menu you can select which sessions the chart is calculated from. You can also
specify to base the chart on only the selected areas in the sessions. For details about selections,
see section 4.9 Selection Tool.

5.3 Manipulating the chart settings

5.3.1 Adding a column or row

To add another row or column in the chart, click on the column or row header where you want to
insert a new row or column. Then select in the Edit menu New column left or right if you want to
add a column, or New row above or below if you want to add a new row. The bin value of the
row/column is initially the average of the neighboring rows or columns.

5.3.2 Changing row or column values

To change the value of a column or row header, double-click on the column or row header. The
column/row entry will become editable:

ol ptsl i

1 02 {AFR

o0 [ 2| 2000
2204 |22.37 [:

]

When you are done entering a new value, hit the ‘Enter’ key to make the change permanent. The
row/column will be inserted at the right place in ascending order.
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5.3.3 Copying/pasting row and column settings

To copy row and column settings, select the column/row headers you want to copy by clicking
and dragging over the header. Then select in the Edit menu Copy Selection.

To paste new values in the row and column headers, select the rows or columns which you want
to replace with the copied settings. Then select in the Edit Menu Paste Settings.

NOTE:
You can also paste in settings created by other programs like Excel as long as these
programs put the values as tab-delimited text on the clip-board of the computer.

5.3.4 Changing the Chart channels

In the Table menu, select Table Setup... the following dialog box appears:

— Harizontal Axiz
Charirel IHF'M j
From IU to |1 0oag =1=T¥!
Mumber of steps |11 [rmax 1:28]
—Werhical Az
Chanrel IThr-:uttIe j
From |n.u b |12c|.c| %
Murnber of steps |13 [max 128
— Chart Content
Channel I LKM1_ 0z j
Cancel |

If you just change the content channel, the current row and column settings of the chart will stay
untouched. If you change either of the axis channels, the settings for that axis (rows or columns)
will change to be equally spaced with the number of steps and end values specified in this dialog
box.

5.3.5 Deleting rows or columns

Select the rows or columns to delete, then in the Edit menu select Delete Selection.
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5.4 Colorizing a chart

Select the Colors menu.

LM1_02
[AFR)
Colors 33
Mo Color 70 — Max Tab
v Color by average value 18
Color by Std. Deviation 18 l
Color by Mumber of data points 14
Color Schemes: ' I-
v  Rainbow 1 p Min Tab
Wobniar :
Planck
Weather i

You can color a chart by average value, Standard Deviation or Number of data points. You can
also choose between 4 different color schemes. The Colorize pane will become active as shown
above.

By moving the Max and Min tabs you can limit the colorization to the value range you are
interested in. The range can be limited to as small as 10% of the total range of the channel.
If colorizing by Number of datapoints the scale for the colors is logarithmic.

Example of a colorized chart:

Throttle (%) RPM  LWM1 032 [AFR)
0 1111 | 2222 | 3333 | 4444 | 5558 | 6867 | 7778 | 8889 |1

0.0 15.06

10.0 15.04 |16.18

200 14.88

30.0 14,84

400 14.42 14

50.0 14 67 " =R

80.0 14.09

700 1367 E

800 14.41 [14.52 &

20.0 H14.31

100.0 13.87 [13.72

4am om 1 1

5.5 User sub-charts

User sub-charts are sub-charts that contain user entered or calculated values.
User chart contents are saved when the log file is saved.

5.5.1 Creating a user sub-chart
To create a new user sub-chart manually, In the File menu select New user chart...
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A new empty user chart with a default name will be created. You can change the name of the
user chart by selecting it with its tab and then, in the Table menu select Change user chart
name...

USE ONLY NUMBERS AND LETTERS IN A SUB-CHART NAME. THE ONLY SPECIAL
CHARACTER ALLOWED IS THE UNDERLINE CHARACTER _ .
A SUB-CHART NAME MUST START WITH A LETTER.

User charts can also be created by the Chart Calculator (see section 6.8).

5.5.2 Entering data in a user sub-chart

To enter data in a field in the user sub-chart, double click on a bin. The bin becomes editable and
you can enter values manually.

5.6 Exchanging chart data with other programs

There are several ways in which chart data can be interchanged between LogWorks and other
programs.

5.6.1 Saving charts

Use the Save Chart menu item in the File menu. The entire chart, including all sub-charts, are
saved in a .dif file. DIF files (Data Interchange Format) can be opened by many programs,
including Excel.

5.6.2 Copying and pasting chart data

To copy the chart data to the clip-board, select the data by clicking and dragging. Then, in the
Edit menu, select Copy Selection. The chart data will be put on the computers clip-board as tab
delimited text, which can be understood and pasted in by many programs.

To copy the entire current sub-chart, including the column and row headers, select in the Edit
menu the item Copy current view.

You can paste data from other programs into user sub-charts, but not into the standard sub-
charts. The other program must be capable of putting the data as tab-delimited text onto the clip-
board.

To paste the data in the user sub-chart, select the top-left bin of the area where you want to paste
the data. Then, in the Edit menu, select Paste Data. The current view in the chart/graph pane
must be a user sub-chart.

5.7 Overlaying charts

You can overlay one sub-chart over another so you can view both at the same time.
In the View menu, select the sub-chart from the Overlay on current view sub-menu.
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To switch off overlays, in the View menu, select Overlay view off.

An overlay view looks like this:

2000 2000 | 2000 |100.
22.20 18.34 [ 12.35
(0.73) [4.09) | {0.74)

1488 [ 14.38

[3.68) | {0.15)

1408 [ 11.73

[3.57 -]

13.87 | 20.24

2 45) -

14,44 [ 1577

The overlayed sub-chart is shown in the bins in italic and parenthesis ().
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5.8 Viewing a sub-chart as 3D-graph

In the View menu, select View as graph.

The 3D chart window changes to look like this:

Il LM1_02 Chart over RPM/Throttle 1Ol x|
File Edit Sessions Table View Graphic Colors
Average | Std Devl MHumber ptsl b an I bir I
LM1_02 . REM @ —
[AFR) ! A Throttle @ —
59 |Average
20 = Std Dev
- —
18 Nurmber pts
1= .
. 1o iz
L1 _O2
14 " -
hin
12 .
10
]
T om | N

Or, if colorizing is switched on, like this:

Il LM1_02 Chart over RPM/Throttle -0l x|
File Edit Sessions Table View Graphic Colors
Awerage | Std Devl MHurnber ptsl b & I kir I
LM1_02 RFM & —
(AFR) 4 i Throtile @ -
a9 |Average
20 = Std Dev
15.14 - —
15 Number pts
1= .
i l T i
LM 02
14 e =
{13.15] hlin
12 .
10
]
Average T m ) I 4 I I_PI
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The 3D surface represents the content data of the currently selected sub-chart. The x and y axis
are the independent channels, the content channel is the z-axis. The grid lines represent the
spacing of the columns and rows. But the scales are equally spaced for easier readability.

The graph view can be selected to be either surface, mesh or both (see Graphic menu). A mesh
view looks like this:

In a mesh view, neighboring data points in the table are connected by black lines. But only
neighbors above/below or left/right are connected, not diagonal neighbors.
A surface only view (colorized) looks like this (without and with mesh):

10 0

- s
-~

7

The surface is constructed according to the following rules. If a datapoint has 2 or more neighbors
(incl. diagonal) a triangle is drawn on the surface. Otherwise the datapoint is shown as 3D cross.
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5.8.1 Manipulating the graph view

The graph is basically a 3D surface representing the dependency of the content channel from the
x and y channels. The 3D surface (including the measurement grid and scales) is projected onto
the chart/graph pane as if it were photographed by a camera. When changing the camera view
the grids are always positioned such that they are ‘behind’ the surface or mesh as seen from the
camera position. The scales are also moved to the edge of the grid that projects with the longest
line on the pane so that the scale numbers overlap as little as possible.

You can manipulate the camera position and zoom with the following user actions:

a. Cameraview angle

Click on the graph with the left mouse button and move the mouse. Moving the mouse left
and right rotates the camera around the graph left or right, but leaves the focal point (where
the camera is pointed to) the same. Moving the mouse up and down rotates the camera
vertically around the focal point.

b. Camera pan
Hold down the Ctrl button while clicking and dragging the mouse. This moves the camera
focal point and effectively moves the graph in the window.

c. Camerazoom
Click on the graph with the right mouse button and move the mouse up and down. Moving
the mouse up zooms in closer, moving the mouse down zooms away.

When the mouse is moved (without a mouse button pressed) over the graph, LogWorks
effectively shoots a ray into the picture (like shooting a gun from the camera position). If that ray
hits the graph, the closest bin-point is calculated and the values of all the sub-charts at that
position are shown in the measurement pane.

If you get lost zooming and panning, the camera angle and zoom value can be reset at any time
by selecting in the Graphic menu: Reset Camera Position.

5.8.2 Glyphs

Glyphs are in computer visualization indicators of additional data drawn on a visualized view.
LogWorks can show the Standard Deviation or the Min/Max points of each bin as glyphs. In the
Graphic menu select Indicate Std. Dev. or Indicate Min/Max Values to show the glyphs for Std.
Deviation or Min/Max. The glyphs are indicated as vertical lines emanating above and below a
data point. The end-points of the lines indicate the Min or Max values or the deviation inside the
bin from the average value.

NOTE:
Glyphs can be added only when the current view shows the average values of the bins.

Here’s a view of a Min/Max glyphed surface:
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5.8.3 Overlays on 3D graphs

Just as you can in the table view of the charts, you can overlay another sub-chart in the graph
view as well. Select which sub-chart you want to overlay in the View menu.

Overlays are shown in gray, half transparent as in this view:

a0

L0 M by ofs

Here the number of datapoints sub-chart is overlayed on the colorized average view.
As the sessions included in this chart are mostly at WOT, most of the datapoints are located at

the WOT line.
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5.9 Calculations with charts

You can use the Math calculator built into LogWorks with charts as well. It is then called Chart
Calculator. To call up the chart calculator select in the Table menu the item Chart Calculator...
See section 6 Math Trace Calculator and section 6.8 Chart Calculator for details on how to use
the calculators.

Calculation results can be stored in a user chart. If a user chart is created with the Chart
calculator, it can be recalculated (for example if it's source data changed) by selecting
Recalculate Math Charts in the Table menu.

Frequently used chart calculations can be stored in a chart calculator library. The library is a text
file named ChartMathlib.txt. The library can be called up by selecting Chart Calculator
Library... in the Table menu.

Details on how to use the Math libraries can be found in section 7, LogWorks Libraries.

A simple very often used calculation is built into the charts function without using the calculator.

When viewing one of the standard sub-charts, double-click on a bin. The following dialog box will
show up:

Chart Info x|

Walues at: AP [E500...6500) RFk
and: Throttle [95...1058] &

~AFR

Average: 12.4 AFR
Std. Deviation: 0.1 AFR
Min. Walue: 12.2 AFR
Max. Yalue: 12.3 AFR
Mumber datapointz: 43

T arget AFR: |1 24

Change fueling by factar 1.000

Calculate |

This shows the current values of the clicked field. The target AFR or Lambda calculation functions
are only available if the field content is AFR or Lambda. The fueling change calculation is based
on fuel flow control where higher numbers represent more fuel.

The fueling factor is calculated by dividing the actual average AFR by the target AFR.
If for example your EFI is set by injector timing, just multiply the timing setting by the suggested
number.

This number is a suggested value only, different EFI systems will react differently.
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5.10 Realtime indication in the chart and graph

If the chart is opened for a realtime log while recording, or while playing back a log, the current
engine state (the bin it is running in) is indicated in the chart (table) view by highlighting the
appropriate bin as in this:

o7 |2022]
s41 [14.44 [18.27
1478 [15.20 [14.88
81 [12.57 [12.87 [15.00 L
168.86 [18.73 |14.47
15.96 |12.64 |18.82 |15.82

12.82 (14.01 |12.78 |14.38

12.25 [12.77 |[EEl 12.21

Or as a ‘bouncing yellow ball’ in the 3D graph as in the example on the right.

Note:

In the graph view the position of the ball shows the real current values the engine is
running, not just the bin it is running in.

Do not use the realtime view of the 3D graph unless your computer is at least a 800MHz
Pentium Il and has a graphics system with 3D acceleration. The 3D graph updates and
warps in realtime as the data becomes available. The processing requirements for that are
very intense.

5.11Some tips on working with charts

You have to be careful when using the chart for tuning the main fuel map of your EFI system. The
chart reflects what's in the log, including transition points and so on. So acceleration enrichment
and possible warm-up enrichment are reflected in the averages as well. The best way to create a
chart is to create an as long log as possible with steady load points. This way the effects of
transitions are minimized. The fewer data points are represented, the less reliable the data. This
is reflected as well in the standard deviation.

Acceleration runs in low gears are not ideal for calculating the load points. The same problem as

in inertial dynos exists. The acceleration enrichment might still be active and reliable load point
data can't be extracted from only a few data points.
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6 Math Trace Calculator

Math Trace x|

Channel

Enter farmulazs here R esuilt

Pehicle weight in b = m[3000]

TTire diameter in inch = td[25]

PhEear ratio of run = gear_ratio[1.21]
TFinal drive ratio = finaldrive[4.53]

P Mame of RPM channel = rpr[F PR ]
PFrontal area of vehicle [zgft] = Ar[19.83]
P0rag coefficient = Cd[0. 32]

PCurrent atmoszpheric pressure [inHg) =
atmp[29.92]

TCurrent temperature [degF) = termp[34]

HSAE correction factor
SAEcf =[1.18 % [[23.235/atmp] * sqrt{[temp

+ 459 67)/536.67]) - 018 -
hd [l KN :
Frint farmula | Print rezults |

Save Changes |

In the left window pane of the calculator you enter your calculations. The right side pane shows
the results (incl. intermediate results) of that calculation.

You can cut and paste in the left window pane using the standard Window cut and paste
shortcuts like Ctrl-X for cut, Ctrl-C for copy and Ctrl-V for paste. Right-clicking in the pane brings
up a standard Window edit menu that can also be used for cut-n-paste.

With the Channel menu you can insert a channel name in the current cursor location without
having to type in the name carefully and correctly.

NOTE:
Trace calculations can’t be executed in realtime, while recording.
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6.1 Calculator basics

You can write formulas however you want to create new channels from existing data or calculate
stuff.

There are certain rules you need to follow.

The following examples show how to use the Calculator: Formulas and calculations can be
entered as described in the examples.

By right-clicking in the formula window you can also cut and paste formulas in as text from any
program.

Comments can be added in the calculation by putting a ‘#' as the first character in a line.

Example 1: Calculate Force (in Ib force) from car mass (Ib) and acceleration (in g)
(Thanks, Isaac N.)

#m is vehicle weight in Ib
m = 3000

ai cceleration in g

mo H#

S a
0.4
m* a

In this example acceleration a is 0.4 g and vehicle mass is 3000 Ib. The result window shows the
acceleration force. Enter the text (or copy it from this manual) and press the Calculate button

In the LogWorks Calculator, multiple variables used for a built-in function are separated by
semicolons, not commas as is usual for most programming languages. Example:

avrg(a;b;c) calculates the average of the variable a, b and c.

The reason is that in some languages, German for example, a comma is used instead of the
decimal point as is usual in English speaking countries. Using a semicolon allows stored
calculations to be used in either case without re-writing. For every formula used, the math
calculator converts numbers with decimals into the respectively used format before doing a
calculation. So in English speaking countries, commas in the text will be converted into colons, or
in countries that use decimal commas, colons are replaced by commas. Calculation formulas can
so be interchanged internationally.

You can also change the formula so the user is asked for the car weight. To ask the user a
guestion you put a question mark at the beginning of the line, followed by a space. Then type in
the question, followed by an equal sign ‘=" and then the name of the calculation variable you want
to assign the answer to.
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6.2 Asking for user data

Example 2: Calculate Force (in Ib force) from car mass (Ib) and acceleration (in g)

? Enter vehicle weight in Ib = m
? Enter acceleration in g = a

F=m?*a

When you press the calculate button here, a dialog box will pop up that allows the user to enter
the values for his application.

If you want to suggest default values for a question, enter the default value in [ ] after the variable
name in the question line as in this example:

? Enter vehicle weight in Ib = m[3000]

The formula calculator libraries (see chapter 7) always store the last entered user values in the
appropriate library entry so they don’'t have to be entered every time they are used.

Formula Calculator allows to use as many intermediate results as you want to make the
calculations clearer. The following example shows how.

Example 3: Calculate torque and horsepower from vehicle weight, acceleration, gear
ratios, tire diameter and rpm

#m is vehicle weight in Ib

m = 3000

#a 1s acceleration in g
a=0.4

F=m?*a

#dia is tire diameter in inches
dia = 25

r = dia/(2*12) #calculate radius in feet

#Ffinal (differential) ratio
finaldrive = 4.53

#gear ratio of the gear in which the acceleration is measured
gear_ratio = 0.82

#and finally rpm
rpm = 4500

torque = F * r / (gear_ratio * finaldrive)
hp = torque * rpm / 5252

Or this time without fixed values, but a questionnaire that has to be filled out by the user
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? Enter vehicle weight in Ib = m
? Enter acceleration in g = a

F=m?*a
? Enter tire diameter In inches = dia
r = dia/(2*12) #calculate radius in feet

? Enter fTinal drive ratio = finaldrive
? Enter gear ratio = gear_ratio
? Enter rpm = rpm

torque = F * r / (gear_ratio * finaldrive)
hp = torque * rpm / 5252

LogWorks collects up to 10 questions into a questionnaire dialog box, so that only a minimum of
dialog boxes pop up. If more than 10 questions are asked, the questions are asked with multiple
sequential dialog boxes of 10 questions each.

6.3 Restrictions on variable names

There are certain restrictions on variable names so that the Formula Calculator can correctly
distinguish between what is an operator like + - * / and a variable or constant.

1. Variable names MUST start with a letter, not a number or special character.

2. Variable CAN ONLY contain letters and numbers, no special characters, with one
exception.

3. The underline character _ is allowed.

6.4 Using LogWorks channels

Suppose you don’t want to enter the values manually, but use data collected in a LogWorks
channel. You can use LogWorks channels as variables just as if you had defined them.

For a simple calculation with only one value as above, the formula calculator chooses the value to
use according to the following rules:

If an area in the visible window is selected, get the first selected datapoint in the window (from left
to right).

Otherwise choose the first selected datapoint in the session

If nothing is selected, use the first (leftmost) datapoint in the visible window.

Example 4: Calculate torque and horsepower from vehicle weight, acceleration channel,

gear ratios, tire diameter and rpm

? Enter vehicle weight in Ib = m
F=m* ACCEL
#ACCEL is the acceleration channel from the LMA-3
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Enter tire diameter In inches = dia

r = dia/(2*12) #calculate radius in feet
? Enter final drive ratio = finaldrive

? Enter gear ratio = gear_ratio

? Enter rpm = rpm

torque = F * r / (gear_ratio * finaldrive)
hp = torque * rpm / 5252

If the channel name is not known initially because the user might have assigned a different name
to it, you can ask for the acceleration channel as in this example:

?1 Enter your acceleration channel name = a

The Formula Calculator knows from the i following the question mark that a channel name is
requested, not a number.
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6.5 Calculating new LogWorks channels

Suppose you want to create a new channel from existing data. This channel can be used then
just like any other channel in LogWorks. The LogWorks restriction of 32 channels includes
calculated channels.

NOTE:

The restrictions on variable names also apply to channel names used in the calculations.

Example 5: Calculate torque and horsepower channels from vehicle weight, acceleration
channel, gear ratios, tire diameter and rpm channel

)

Enter vehicle weight in Ib = m
F=m>* ACCEL #ACCEL is the acceleration channel from the LMA-3

)

Enter tire diameter in inches = dia
r = dia/(2*12) #calculate radius in feet

? Enter final drive ratio = finaldrive
? Enter gear ratio = gear_ratio

trq = F * r / (gear_ratio * finaldrive)
MC(power;hp) = trqg * RPM / 5252 #RPM is the RPM channel

MC( ) indicates that a new channel is to be created (Make Channel). The first word after the
parenthesis ( ‘power’ in the example) is the name of the new channel. The second word,
separated from the first by a semicolon, is the unit assigned to the channel.

The format of the MC command is:
MC(channel_name; channel_unit; minimum_bound; maximum_bound)
The channel unit, minimum_bound and maximum_bound are optional. See below.

LogWorks channels also have ‘bounds’. The bounds are there to limit what is shown on the main
session window to the interesting region. Input channels are naturally bounded by the input
capability of the LM-1, LMA-3 or other data collection devices, typically 0..5V. Calculated
channels have no such natural limits. When no bounds are specified, the MC command
calculates the minimum and maximum of the bounds automatically by looking at the minimum
and maximum of the calculated trace in all sessions. This can lead to too large a range because
calculations are always performed on all sessions in a log.

To limit the min and max bounds select the areas in each session you are interested in
calculating. When areas are selected, the formula calculator will only use the selected
areas for the bounds calculations.

You can also set fixed bounds by adding the bounds to the MC command like this:
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MC(power;hp;0;500) =trqg * RPM / 5252 #RPM is the RPM channel

This will now create a channel with bounds of minimum 0 hp and maximum 500 hp. This
eliminates for example negative hp values created during braking.

If you want to set the minimum bound only, just leave out the maximum as in this:

MC(power;hp;0) =trgq * RPM / 5252 #RPM is the RPM channel

If you want to set the maximum bound only, just leave out the minimum, but use 2 semicolons as
in this:

MC(power;hp;;500) =trg * RPM / 5252 #RPM is the RPM channel

Note:

LogWorks stores the data in 10 bit words. This means that the results are stored with a
resolution of about 0.1%. Therefore calculated channels should not be used in further
calculations. Calculate one channel at a time.

For example:

MC(trqg; Ibft)
MC(power ;hp)

F * r / (gear_ratio * finaldrive)
trq * RPM / 5252 #RPM is the RPM channel

Would work, but can create wrong results because trq is stored with 10 bit resolution and then
used in the hp calculation.

Instead recalculate or assign the torque channel as in this:
trqg = F * r / (gear_ratio * finaldrive)

MC(torque;lbft) = trq
MC(power;hp) = trq * RPM / 5252 #RPM is the RPM channel
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6.6 Dealing with units

Sometimes a channel used for a calculation is in a different unit as required for the calculation.
For example if the user set ft/sec”2 as acceleration metric, but the calculation requires g's.
You can force an automatic unit conversion by using the unit converter operator.

Example 6: Automatic unit conversions

? Enter vehicle weight in Ib = m
F = m * ACCEL{g}

The curly braces { } around the desired unit after a channel name recalculates that channel
temporarily to the new unit.

Once a channel is converted, you can’t convert it again in the same calculation. The converted
channel will be used for the rest of the calculation and further {}'s after a channel name will be
ignored.

If a question for a channel name is asked from the user, the automatic unit conversion can also
be automatically invoked to make sure the channel is correct for the calculation.

?1 Enter your acceleration channel = a{g}

This recalculates the acceleration channel into gs temporarily.

If the unit conversion requested is unknown to LogWorks, a dialog box will pop up that asks how
to convert the unit:

x

Cannot corvert ACCEL from mile/hourses to g

Enter corverzion formula.
IJze 'ou’ az place holder for the aniginal unit

g=ou*21.9368519

Cancel | ok I

The formula uses ‘ou’ as placeholder for the original unit.
Enter the formula and the calculation will proceed.

For details on the unit conversion, see chapter 8 How LogWorks unit conversions work.
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6.7 Formula Calculator Functions

Rules:
e |f a function uses multiple arguments, like floor(x;10), the arguments are separated by
semicolons.

The Formula Calculator has the following built-in functions, operators, constants and values

Pre-assigned constants and values

e 2.71828182846
pi 3.14159265359
t time in seconds from begin of session

Math Operators

+ Addition

- Subtraction

* Multiplication
/ Division

N

Power of, as in x*2 would square x

Boolean Operators

Boolean operations result in just one of 2 possible results: 1 or 0, equivalent to true or false.
The following Boolean operators are built into the Math Calculator:

& AND, as in a & b. Resultis 1 if both, a and b, are 1.

| OR, asina|b. Resultis 1 if either a or b are 1.

! NOT as in !a. Resultis 0 if ais not 0. Resultis 1 of ais 0.

== EQUAL asin a==b. Resultis 1 if ais equal to b. Otherwise result is 0.

I= UNEQUAL as ina!=b. Resultis 0 if a is equal to b. Otherwise result is 1.

> GREATER THAN as in a > b. Resultis 1 if a is bigger than b.
< SMALLER THAN as in a <b. Resultis 1 if a is smaller than b.
>= GREATER OR EQUAL as in a>=h. Resultis 1 if a is bigger or equal to b.
<= SMALLER OR EQUAL as in a <=b. Resultis 1 if a is smaller or equal to b.

Regular Math Functions

abs Calculates absolute value ( -x turns into x)

acos Calculates arc-cosine as in acos(x)

asin  Calculates arc-sine as in asin(x)

atan  Calculates arc-tan as in atan(x)

avrg  Calculates the average of multiple values as in avrg(a;b;c;d)

ceil Limits value to a maximum as in ceil(x; 10) would limit x to a maximum of 10
cos Calculates cosine as in cos(x)

cosh  Calculates hyperbolic cosine as in cosh(x)

fact Calculates the factorial of x as in fact(x) calculated as x*(x-1)*(x-2)*...(x-x+1)
floor  Limits value to a minimum as in floor(x; 2) would limit x to a minimum of 2
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max  Returns the largest of a set of variables as in max(a;b;c;d)
min Returns the smallest of a set of variables as in min(a;b;c;d)

In Calculates the natural logarithm (base €) of x as in In(x)
logl0 Calculates the base 10 logarithm of x as in log10(x)
sin Calculates sine as in sin(x)

sinh  Calculates hyperbolic sine as in sinh(x)

sqrt Calculates square root as in sqrt(x)

sum  Calculates the sum of multiple values as in sum(a;b;c;d)
tan Calculates tan as in tan(x)

tanh  Calculates hyperbolic tan as in tanh(x)

Note:
Trigonometric functions (sin, cos...) use radians arguments, not degrees.

Special channel functions
slope Calculates the slope (or differential) of a channel as in slope(channel).

area Calculates area under the channel curve or partial integral (or area)
as in area(channel; t0; t1) where t0 and t1 are constants in seconds in the session. Can
also be used as in area(channel; t-10; t+10) to calculate running area (integral).

Notel:
The slope functions will only take a channel name as argument, not an evaluated function
as in slope(channel * x + y).

The automatic unit conversion operator can be applied though.

Note2:

Slope calculations are very sensitive to noise on the channel. To minimize noise it is better
to smooth the channel before applying the calculations. As a rule, smoothing of 0.25t0 1
second is enough in most cases (reasonably smooth data to begin with). Experiment with
the right smoothing value for your application.
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6.8 Chart Calculator

The chart calculator usage is exactly the same as for the Math Trace Calculator. With the
following differences:

Channel names CANNOT be used as variables

Sub-chart names can be used as variables.

The special math functions slope and area cannot be used.

The MC special function stands here for “Make Chart”.

The additional variables for the MC function, like unit and limits, are ignored. MC creates
a new user chart.

e The 't’ variable for time is not available

e Standard sub-charts can be modified

Because sub-chart names can be used as variables, the same restrictions as for general variable
names applies here too. See section 5.3, Restrictions on variable names for details.

6.8.1 Pre-assigned names for the standard sub-charts:

chart_avrg The “average value” sub-chart.
chart_num The “number of datapoints” sub-chart
chart_stddev The “standard deviation” sub-chart

chart_min The “minimum value” sub-chart

chart_max The “maximum value” sub-chart

chart_X The horizontal value (column header) of the bin used
chart Y The vertical value (row header) of the bin used

6.8.2 Using the Chart Calculator

Here are a few examples on how to use the chart calculator:

Example 1: Filtering the chart so that only values with more than 50 datapoints are used:
chart_num = (chart_num > 50) * chart_num

In this case, the number of datapoints is reset to 0 (empty) if it has less than 51 datapoints in it.

The term (chart_num > 50) evaluates to 1 if the number of datapoints in the bin is more than 50,

otherwise to 0. So, chart_num stays either the same (chart_num * 1 = chart_num) or becomes 0
(chart_num * 0 =0).
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Example 2: Calculating a horsepower sub-chart from a chart containing torque:

For this example the chart_average view contains the engine torque in Ibft, the column headers
(horizontal axis of the chart) are in RPM.

MC(power) = chart_avrg * chart_X / 5252

Example 3: Calculate a new fuel map based on an existing fuel map sub-chart and a target
AFR sub chart:

Requirements:

a.
b.

c.
d.

The chart_average view contains the measured AFR over RPM and MAP/MAF or
Throttle position.

There is a sub-chart named current_map that contains the current fuel map

There is a sub_chart named target_afr that contains the target AFRs for each bin
The fuel map is linearly related to the injector duty cycle, where 0 means no fuel and
some max value means 100% injector duty cycle.

MC(new_map) = current_map * chart_avrg / target_afr
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7  LogWorks Libraries

LogWorks has multiple libraries. These libraries are used to store frequently used searches or
calculations. When using the LogWorks Log Window, the Trace Libraries or the search Library is
used. When using the 3D chart, the Chart Library is used.

Each library entry or formula has a name under which it can be easily identified, and (optionally) a
category to which it belongs to further simplify and find calculations or searches.

So that distracting duplicate entries are avoided, the Trace Library is divided into two parts. One
part is in US units, the other in international units. You select which Library is used by selecting
the appropriate Preferences in the LogWorks Main Window menu.

Libraries are plain text files. So they can be opened and edited by any text editing program, even
the simple Notepad program built into Window. In practice, this is rarely necessary because the
Library editor built into LogWorks can accomplish all Library management tasks. For details on
the file format of Library text files, see chapter 7.4 Library formats.

The library files must be in the same folder as the LogWorks.exe program for LogWorks to
find them.

7.1 Using the Libraries

7.1.1 Basic usage

Log Window:
Select Formula Collection... in the Tools menu for trace calculations.
Select Search Library... in the Edit menu for frequently used searches.

3D chart window:
Select Chart Calculator Library... in the Table menu for chart calculations.

The following dialog box will appear:
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x4
Categary I-ﬁ-ll j

Farmula IFueI flow [Ibhr] from duty cycle j

Farmula D ezcription

Fuel flow inj. duty cucle -]

- requires user input af inj. zpec [lbAhr)

- and zpec'd fuel pressure [PSI]

- fuel presszure [PS1] above Manifold prezsure
- hio rizing pressure regulator

Delete Formula Save Changes | - Edit Formula |

With the uppermost field, you can select or edit the category the calculation belongs to.
In the middle field you select or edit the formula name.
The lowest field shows and allows you to edit a short description of the formula.

To delete the formula from the library, click on the Delete Formula button.
To save possible changes you made to the name, category or description, click on the Save
Changes button.

To change the formula itself, click on the Edit Formula button. The Trace Calculator dialog box
will show up and allow you to change the formula.

To execute the selected formula, click on the Use Formula button.

Note:
When entering user values in a formula during use, the entered values are stored in the
library as defaults, so that they don’t have to be entered every time the formula is used.

For a tuner that tunes multiple cars it would be of advantage to copy the libraries to a different
(customer specific) folder as the libraries contain the last default values. Then copy the libraries to
the LogWorks Folder when the customer car is retuned. This way the customer’s last calculation
values are restored as defaults.

7.1.2 Adding a new formulato a library

If you entered a new formula in either the Trace calculator, Chart calculator or Auto-search
window, you can make it a new library entry by clicking the Add to Library button in the calculator
or search window. The same dialog box as above will show up. Enter the name of the new
formula in the middle field. Enter a short description in the bottom field. Select a category or enter
a new one in the uppermost field.
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7.2 LogWorks built-in Trace calculations

These are the calculations built into LogWorks for calculating new channels or traces. Check on
the Innovatemotorsports web site (www.Innovatemotorsports.com) for additional calculations as
they become available.

To understand the calculations a few things must be known by the user:

a. Every calculation is only as good as the data used as basis for the calculation. This is
especially true for horsepower and torque calculations.

b. Many time based calculations are based on an engine cycle. A 4-stroke engine cycle
requires 2 engine revolutions.

7.2.1 Category: Fuel Calculations

Fuel flow (Ib/hr) from duty cycle (US) or (cc/min) for Internat.

Requires you to enter the specs of the injectors used (Ib/hr) or (cc/min), their rated pressure in
PSI (US) or kPa (int.), the injector duty cycle channel name (easy if you have an LMA-3), the fuel
pressure the regulator is set to, and the total number of injectors.

Creates a fuel flow channel in Ib/hr or cc/min total for the engine.

Note: Specifying injectors in Ib/hr is actually a misleading metric. Injectors flow a certain volume in
a specified time. Because most fuels have very similar viscosity, but very different specific mass,
an injector rated for example for 10 Ib/hr will flow 10lb per hour of the test gasoline, but a very
different number of Ibs for example for methanol.

7.2.2 Density and VE

Intake air density

Calculates an air density channel in Ib/cuft (US) or kg/m”3 (Internat.) from intake air temperature
and absolute intake air pressure (MAP) channels.

7.2.3 Power calculations

These calculations result in two channels, one for torque and one for power. The US version of
the calculations result in a torque channel in Ibft and a horsepower channel in hp. The
International versions result in a torque channel in Nm and a power channel in kW. You can
easily change the formulas to get the results in the units you want.

Because these calculations are based on the acceleration of the vehicle, the speed of the vehicle
must be known. It is assumed the test runs are done in a single gear (3" gear for example).
Because vehicle speed is calculated from gear ratios and tire diameter, the calculations will be
unreliable for an automatic transmission vehicle below the converter lockup rpms. They will be
correct at rpm levels above converter lockup. Because a vehicle does not accelerate any more at
top speed, for calculations based solely on acceleration alone, the torque (and therefore
horsepower) would be zero there. That's of course not the case. The calculations therefore also
require to put in the frontal area and Cd value of the car to calculate aerodynamic resistance
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force. As this force is speed dependent and acts against the acceleration force, it must be
accounted for. The frontal area and Cd value for many cars can be found here:

http://www.mayfco.com/tbls.htm

The resulting values are corrected for different meteorological conditions as well as using
standard SAE correction.

To use the power calculations correctly, use the selection tool to select ONLY the areas of
full throttle at the correct gear.

The results should not be relied upon in the areas at the edges of the selected areas. Rounding
of the signal by smoothing will effect the calculated results at about 1 second from the edges if a
smooth value of 1 second is used. Smoothing is required for calculations involving slopes
because slope calculations will vastly exaggerate any noise or digitizing artifacts in the signal.
These artifacts show up as oscillations on top of the calculated channel.

The required data to be entered must be as accurate as possible. The vehicle weight entered is
the weight as tested, incl. fuel, liquids and driver, not the dry weight.

The aerodynamic force calculations are based on dry air. The published numbers by the
manufacturers might be on the low side of actual, even for an unmodified vehicle. Addition of
aerodynamic devices like wings, splitters, side-skirts and so on can drastically change the cd-
value and frontal area. The same is true for wider tires, lowering and so on.

NOTE:
These calculations should be used to compare the results of modifications made to

fueling and/or timing and their relative effects on power and torque. They are NOT
intended as replacement for dyno time if the actual power and torque numbers are needed.

Torque/power from Accel/RPM
This calculation uses primarily the acceleration channel from the LMA-3 and RPM to calculate

torque and power. It also uses the tire diameter and gear ratios to calculate speed for the
aerodynamic force calculations.

Torque/Power from speed and acceleration signal

This calculation uses a speed signal input and acceleration signal from the LMA-3 to calculate
torque and power.
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7.3 LogWorks built-in chart calculations

These are the calculations built into LogWorks for calculating with charts. Check on the Innovate
Motorsports web site ( www.Innovatemotorsports.com ) for additional calculations as they
become available.

7.3.1 Fueling calculations

Fuel map from measured AFR and target AFR
Requires a current fuel map as input chart (user sub-chart) and a target AFR sub-chart.

The current fuel map values are assumed to increase linearly with injector timing, where 0 means
no injection (injector cut off).

7.4 Library file format

If you feel the need to edit the libraries directly with a text editor, this section shows the file
format. All libraries have the same basic format. Irrespective if it is a chart library, trace library or
search library.

The library managers use special comments in the formulas to identify individual formula entries.

These special library comments use a double comment marker (##) at the beginning of a text
line, followed by the text.

7.4.1 Name comment

Format:

##Nformulaname

The comment starts with ##N, followed immediately by the name of the formula. This is a
required comment. The Library managers identify formulas as the text between formula name

comments. This means a formula entry starts with the formula name and ends at the beginning of
the next formula name or the end of the text file.

7.4.2 Category comment

Format:
##Cformulacategory

This comment is optional and, if used, follows the Name comment. The comment starts with ##C,
followed immediately by the category used for the formula.
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7.4.3 Description comment

Format:

#H[
Multiple lines of comment text
#]

This comment is optional and, if used, follows the category comment. If no category comment is
used, it follows the name comment.

The library manager strips out any text between the ##[ and ##] description markers before
handing a formula to the calculator.
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8 How LogWorks unit conversions work

To automatically convert units, LogWorks uses a special library file named Conversions.txt.
This file must be located in the same folder as the LogWorks.exe file.
You can manually extend the number of conversions LogWorks understands by editing this file.

Additional conversions for many units can be found here:
www.onlineconversion.com

NOTE:

Avoid multiple conversions back and forth. A computer has a limited resolution for
numbers which creates rounding effects, and these rounding effects add up after a few
conversions and will create inaccurate data.

8.1 Conventions on unit names

For LogWorks to understand a conversion, certain conventions must be followed:

8.1.1 Temperature conventions

Temperature measurements are in degrees Celsius, degrees Fahrenheit or degrees Kelvin.

Celsius units are named degC
Fahrenheit units are named degF
Kelvin units are named degK

8.1.2 Pressure conventions

Pressures used in engine diagnostics are either in gauge pressure or absolute pressure.

Gauge pressure is typically what a boost or vacuum gauge measures. It is actually the pressure
difference to the current atmospheric pressure, not the actual pressure itself.

Absolute pressure is the pressure above absolute vacuum. This is what most MAP sensors
measure. MAP stands for Manifold Absolute Pressure, not Manifold Air Pressure as a lot of
people think.

The fueling or AFR value of an engine is a measure of the ratio of the mass of air entering the
engine divided by the mass of fuel. The mass of fuel, being a liquid, changes little with pressure
or temperature. Air, being a gas, changes dramatically. Doubling the absolute pressure with no
change in temperature, will double the mass of air entering and therefore would also require
double the fuel for the same AFR. The air mass is dependent on ABSOLUTE pressure in the
manifold, not gauge pressure and is also dependent on temperature.

Pressures are mainly measured in PSI (US, pounds-per-square-inch) or kPa (international, kilo-
Pascal). The kPa value is by convention an absolute pressure value.
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To distinguish between gauge pressure and absolute pressure it is common to add a ‘g’ at the
end of a gauge pressure unit and an ‘a’ at the end of an absolute pressure unit. If the ‘a’ is
omitted, absolute pressure is assumed. Sometimes also a ‘vacc’ is added instead of a ‘g’ to
denote a vacuum measurement. This is typically used for carburetor tuning and is done in the US
as inches of vacuum. This is a gauge pressure unit and indicates again the pressure difference to
atmospheric pressure. InHgVacc is a typical unit for vacuum measure. It means how high (in
inches) the given vacuum could suck up a column of mercury (chem. sign Hg).

In reality the mercury is not sucked up, but pushed up by atmospheric pressure.

Another vacuum measurement unit is mmHg. It's the same as InHg, but expressed in millimeters,
not inches.

When converting between absolute pressure units and gauge pressure units the LogWorks built-
in unit calculator will ask you for the current atmospheric pressure. You can enter the atmospheric
pressure either in millibar or inches of mercury. Any barometer or weather station/radio will give
you the atmospheric pressure in one of those two units. LogWorks will store the entered value in
memory.

8.2 The Conversions.txt format

You can add comments in the file by preceding a line of text with a #.
All text in the line behind the # is ignored by the unit calculator.

To reduce the number of conversion formulas required, LogWorks uses a two-step approach to
the conversions.

First the source unit (the one you are starting out with) is converted into a master unit. You can
use any unit as master unit, but make sure all units of the same family are using the same master
unit. For example for pressure the master unit is kPa. A unit family is a group of units measuring
the same quantity, like pressure or temperature.

In the second step the converted value (converted to the master unit) is converted to the target
unit (the one you want to convert to).

Example to convert PSI (absolute) into bar (absolute):

PSla (absolute pressure in PSI) is converted first into kPa.
Then the kPa value is converted to bar.

In the formulas for the conversion the name ‘ou’ stands for original unit.

A typical example for is the conversion formula for converting PSla to kPa:
PSla > kPa=o0u *6.8947573

This means to LogWorks:
To convert PSla to kPa, multiply the original unit (PSla) by 6.8947573

Another pre-programmed variable name used by the unit calculator is ATMP.

ATMP stands for atmospheric pressure. Internally LogWorks stores the current atmospheric
pressure in kPa. When you enter the current atmospheric pressure, LogWorks decides what unit
(inHg or millibar) was used by looking at the number. If the number is above 100, it's in millibar,
otherwise its inHg. It then converts that number to kPa for internal storage. Initially, when
LogWorks starts up, the value of ATMP is 0. As air-breathing internal combustion engines are
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rarely used in space, LogWorks knows to ask when the current ATMP is required, but its current
value is equivalent to the air pressure in intergalactic space (zero).

Here’s the complete pressure unit family as stored in the Conversions.txt file:

PSI > kPa = ou * 6.8947573
PSla > kPa = ou * 6.8947573
PSIg > kPa = (ou * 6.8947573) + ATMP

kg/cm”2 > kPa = ou * 98.0665

bar > kPa = ou * 100

inHga > kPa = ou * 3.3863887

inHgvac > kPa ATMP - (ou * 3.3863887 )
millibar > kPa ou * 0.1

mb > kPa = ou * 0.1

kPa > PSI = ou / 6.8947573

kPa > PSla = ou / 6.8947573

kPa > PSIg = (ou - ATMP) / 6.8947573
kPa > kg/cm”™2 = ou / 98.0665

kPa > bar = ou / 100

kPa > inHga = ou / 3.3863887

kPa > inHgvac = ( ATMP - ou) / 3.3863887
kPa > millibar = ou * 10

kPa > mb = ou * 10

As you can see, the first half of the conversions all convert a source unit to kPa. The second half
of the conversions convert kPa to another target unit.

The following master units are used in the Conversions.txt file:

Temperatures in degree Kelvin (degK)
Pressures in kiloPascal (kPa)
Acceleration in g

Speed in meters per second (m/sec)
Weight (mass) in kilograms (kg)
Length in meters (m)

Volumes in liters (1)

Power in kiloWatt (kW)

Torque in Newton-meters (Nm)
Frequency in Hertz (Hz)

Density in kilograms per cubic meter (kg/m”3)
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9 Tips & Tricks for using LogWorks

The included log file example Autobahn.log shows a good example of using the features of
LogWorks to determine if a fueling change made a difference in power of the engine.

Let's look at Session 1 and Session 3 in the example. Both are 3™ or 4™ gear pulls from low RPM
to redline. We look at the run from 1300 RPM to 8400 RPM.

Session 1. Time between 1300 RPM and 8400 RPM is 28.18 sec

Il C\...\Release\Autobahn.log - Session 1 - |I:I|5|

File Edit Sessions Channels Tools View

s 5] IT ® Q& | * 0 Seszion length: 37.19 zec

o = 8] 2187 sec |l
= e 12,22 AFR
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Session 3. Time between 1300 RPM and 8400 RPM is 27.93 sec

I C\...\Release\Autobahn.log - Session 3 - |EI|£|

File Edit Sessions Channels Tools View

A 2 ] @) & ED | * N Session length: 32.01 zec
o = o 22.28sec
by 19.25 AFR

&= -
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Now we are using the overlay tool to overlay session 3 over session 1:
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ll C\...\Release\Autobahn.log - Session 1 =10 x|
File Edit Sessions Channels Tools  View
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What is immediately noticeable is that the AFRs of session 3 are higher than those of session 1 in
the area below 7000 RPM, but lower above. Let's see how that affects power and acceleration.
Acceleration can be determined by the slope of the RPM curve. The steeper the slope, the higher
the acceleration and therefore power (assuming other conditions like weight and wind are the
same).

In area 1, acceleration is slightly lower in session 3, while AFRs are higher than in session 1.

In area 2, both RPM slopes match. Therefore the AFR change had little effect.

In area 3, the RPM slope of session 3 is noticeably steeper. The engine made more power with
the leaner AFR.

In area 4, the RPM slope of session 3 is flatter. The engine made less power, but AFRs are richer
than in that area.

You can also see than when you compare the WOT rows in the charts of the session

Session 1
Thrattle [%] BPM  AFR

1500 | 2000 | 2500 | 3000 | 3500 | 4000 | 4500 | 5000 | 5500 | 6000 | 5500 | 7000 | 7500 | 8000 | 8500
100f 134 1134 (1371 [ 130|129 (130 (127 126 (126 (124|123 [123 (124 | 124|123
Session 3
Thrattle [%] RPM AFR

1500 | 2000 | 2500 | 3000 | 3500 | 4000 | 4500 | 5000 | 5500 | G000 | 6500 | 7000 | 7500 | 8000 | 8500
100) 14.7 [ 143 [14.0 | 140 [ 140 (1471|137 135 (133|131 129 (124|121 |[120 (120

You can see that the power curve can be improved by richening up the fields below ~4500 RPM
and leaned out in the fields at 7000 RPM and above.
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This can be even better analyzed when using the Math Trace Calculator Library and the X-Y Plot
function.

For this example all the WOT runs in Session 1..4 in the example file are selected. The RPM
trace is smoothed in those sessions to 1.06 seconds. Then, using the Math library, torque and
horsepower are calculated from gear ratios, tire diameter, cars frontal area, weight and
aerodynamic coefficient, and the RPM slope. The run in Session 3 is overlayed on session one,
and torque, power and AFR together are shown on the X-Y plot:

I Log File X¥Plot (RPM,LM1_032) o =] |
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Again, one can see that at the leaner AFR of the overlayed session the torques are higher,
except at the low RPMs below about 4500. From about 7000 RPM on the overlay torque curve is
lower because the AFR’s are richer than in the original session.

Creating a 3D chart of the torque vs. AFR and RPM dependency for the selected WOT areas
shows what optimum AFR should be used for max power. This chart is created from only 4 runs
(Session 1..4) but illustrates how LogWorks can be used for optimization.

More runs will refine the results.
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L1 &2 (AFR) RPM torgue [IBft)
2000 (3333 | 3687 | 4000 | 4333 | 4667 | 5000 | 5333 (5667 | 6000 (6333 | 66687 |°
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This shows maximum torque is reached at 5000 RPM and 13.33 AFR.

Here’s the same chart as a 3D surface:

(2
120
100
50
torque
(lotty
ran
rda
000
RPM
(PR -on
7000
EI:.:.:I-. T T T T T T T T T 0
120 122 124 124 128 130 132 134 138 138 140
LM 02
A& AR

One can clearly see the trend to a torque peak (1) at about 13.3 — 13.4 AFR for this particular
engine at that engine’s current timing settings. A secondary peak exists at a different RPM at (2).
The key to good tuning of course is to arrive at the maximum torque achievable without engine
knock by varying both, timing and fueling.
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10 Interfacing with various sensors

10.1 Electronic parts basics

10.1.1 Diodes

Diodes let current pass in one direction (Anode (A) to Cathode (K)) and block current in the other
direction. The exception are Zener diodes. They work like regular diodes, but in the reverse
direction they will pass current only when the voltage is bigger or equal to the ‘Zener’ voltage.
This has the effect of limiting the voltage over the Zener diode to the zener voltage.

On a typical diode the Cathode is marked with a ring as in this picture:

Diode Symbol

Diode
KA K A
10.1.2 IC's

Typical IC’s are either surface mount or through-hole. Through-hole ICs are easiest to use. A
typical picture of a 16 pin and 14 pin through-hole IC (DIP) are shown below:

Wiarlk Niarlk:

i %
g W |4 i= =
2 =13 = =15
ig F12 = =14
45 P11 4 =13
ig P10 = =12
£ FS = =11
Td :IS T = :]_E
g =5

Pin-Number counting starts to the left of the mark and proceeds counter-clock-wise around the
chip.

10.1.3 Resistors

Resistors come in many different values and also different tolerance grades and maximum
wattage. Typical tolerance grades are 10%, 5% and 1% with 5% being the most common.
Wattage ratings are 1W or bigger, 1/2W, 1/4W, 1/8W, and so on. The minimum required wattage
rating can be calculated with:

VZIR

Where V is the max voltage the resistor will see, and R is the resistance in Ohms.

The resistance value and tolerance grade on a typical resistor is marked as colored rings
(typically 4). The first ring being close to one of the connection leads.

The first two rings determine the first two digits of the resistance value. The third ring determines
the number of O’s to add to the first two digits to get the total value in Ohms.
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Color Ring1,2 Ring 3 zero’s Color Ring1,2 Ring 3 zeros
value value

Black 0 none green 5 00 000

Brown 1 0 blue 6 000 000

Red 2 00 purple |7 0 000 000

Orange | 3 000 gray 8 00 000 000

Yellow 4 0 000 white 9 000 000 000

So the ring-colors Brown-Black-Red would signify 1-0-00 or 1000 Ohms (1 kOhm).

10.1.4 Capacitors (Caps)

Capacitors come in either polarized or unpolarized varieties. Typically polarized values are used
when the capacitor value is bigger than 1 uF (micro-Farad). All capacitors have also a maximum
rated voltage, which can be fairly low for polarized capacitors. This means that the voltage the
capacitor is connected to in the circuit should be smaller than the rated voltage.

On a polarized capacitor the + side or minus side are marked with a + or a — sign. The + side
must go to the higher voltage.

Capacitor Svmbaol=
(unpolarized)  (polarized)

L ==
-

10.2 Intake air temperature (IAT) or coolant sensors (CT)

Most IAT or CT sensors are actually NTC thermistors. So are many oil-temperature sensors.
NTC stands for negative temperature coefficient. These sensors are resistance type sensors and
their resistance changes such that it lowers with higher temperature. The resistance curve over
temperature is not linear.

Although there are many published resistance curves for commonly available IAT or CT sensors,
these tables typically show only the nominal values. Actual production sensors can vary by as
much as 10% from the nominal values. For many applications, like turbo or intercooler efficiency
calculations, multiple sensors are needed to measure pre- and post intercooler or compressor
temperatures. At the tolerance of production sensors, it is therefore necessary to calibrate them
to get reliable results.

The LogWorks 2.0 Helper application “Thermistorcalc.exe”, which was installed in your LogWorks
folder, can calculate the circuit to use and can also produce a custom input lookup table for
LogWorks.

For that it needs the resistance of the sensor at three different temperatures. The temperatures
MUST differ from each other by at least 25 degC or 45 degF.

10.2.1 Calibrating thermistor sensors
Of the three measurement points, the easiest to get is the middle point. Just leave the sensor in a

warm room (Room Temperature at or above 25 degC or 77 degC for at least an hour. Measure
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the resistance of the sensor with a digital multimeter and write it down. Also record the
temperature with a good thermometer.

Two other easy temperature standards available to everybody are the freezing point of water (0
degC or -32 degF) and the boiling point of water (100 degC or 212degF). Water does not usually
hurt NTC resistor sensors. Just make sure they are thoroughly dried out after the measurement.
To get the 0 degC resistance, fill a small plastic container with a mixture of ice-cubes and water.
Stick the sensor in the middle and hook it up to the multimeter to measure the resistance. Wait
until the resistance has stabilized, indicating the sensor is at the same temperature (0 degC) as
the water.

Next put the sensor in a pot of boiling water and repeat the measurement, again waiting for the
temperature and resistance to stabilize.

10.2.2 Thermistor circuit

Most ECU’s and also the Innovate MTS products do not measure resistance directly, but
measure a voltage. To convert the resistance of the sensor into a voltage requires a 5V power
supply and a load resistor.

The typical circuit for this looks like any of the following schematics:

ECU ECU
+3W Senzor | +5V
MP Load
\[, Resiztor
Senzor g I—c
T Load
] Resiztor
— Ground WP
o Ground

Ground (one wire gensor) L

A. Sensor Grounded B. Sensor at 5V

In case A, the sensor is grounded on one side. This is the most common case where the sensor
body is in physical contact to the engine, and is grounded through its body. Very often these
sensors have only one pin.

To find out, which circuit your ECU uses, measure the voltage between each of the two sensor
pins (if it has two) and ground. If one voltage is zero and the other is some voltage between 2 and
5V when the sensor is cold, you have circuit A. If one voltage is 5V while the other is lower, you
have circuit B.

To get the voltage curve, you also need to know the value of the load resistor. You can’t measure

it directly with the multimeter though, because it would interfere with the ECU and can possibly
damage it. The method to use goes as follows:
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Schematic case A.

1. Disconnect the sensor from the ECU and measure the voltage between ground
and the sensor pin at the ECU (measurement point MP).

2. Switch the multimeter to current measurement and measure the current in mA
between MP and ground.

Schematic case B.

1. Disconnect the sensor from the ECU and measure the voltage between the two
sensor connection pins of the ECU.

2. Switch the multimeter to current measurement and measure the current in mA
between the two sensor connection pins of the ECU.
The load resistance (in kOhm) is the measured voltage divided by the measured current in mA.

If you use a LMA-2 or LMA-3 you have to provide your own load resistor. In case of the LMA-2
you also have to provide a 5V supply. Connect the load resistor and sensor as follows:

LMA-Z or LMA-3

+5V

Load
Resistor

Sensor | e L

% —3 CHx- (onhy on LMA-3)

— Ground

If you are using the LMA-2 or LMA-3 to tap into an existing IAT sensor hooked up to an ECU,
omit the load resistor in the schematic above, but instead rely on the load resistor built into the
ECU, measured as described earlier.

10.2.3 Using the Thermistorcalc program

The Thermistorcalc program creates a thermistor curve by solving the extended thermistor
formula:

In(R) = B1 + B2/T + B3/T®
Where R is in Ohms and T in Kelvin.

Start the Thermistorcalc application. It will show the following dialog box:
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#= Thermistorcalc x|

—Temperaturez in ————————— Feziztance in
v Farenheﬂ: i~ Celsiuz ’V ™ Ohm = kOhm

— Desired Temperature R ange

From |77 to |2'|2 Farenheit

— Senzor iz connected o one side to;
i Ground = 45l

— Resistance/Temperature table

Resistance Temperature MNate:

kOhm Farenheit Tempe_ratures entered
|34_?E| at |.4|:|_|:| izt differ by at least:
1— at F 45 Farenheit

0.06712 at |2120

— Load Resistor Size

Load resistor uged iz IU-3EUU kOhim
Determine bezst Load Resistor | Create Table I

Specify if you want enter the temperatures in Fahrenheit or Celsius. Also, specify if the
resistances used are in kOhm or Ohm and if circuit A (sensor grounded) or B (sensor at 5V) is
used.

NOTE:

Thermistorcalc works only if the circuit (A or B) is run from 5V.

Enter the desired measurement temperature range. The range must be at least 50 degC or 90
degF.

Also enter the three measurement points from the calibration procedure as described above.

If you are making your own circuit, you can have Thermistorcalc calculate the optimum load
resistor. The temperature where this circuit has its maximum sensitivity is when the resistance of
the sensor and the load resistor are equal. Thermistorcalc calculates the sensor resistance at the
mid-point of the specified range and outputs the closest standard resistor value to that.

NOTE:

Do not make the load resistor smaller than about 1/5" of the thermistor resistance at room
temperature.

Once all fields are filled out, click on the ‘Create Table’ button. Thermistorcalc will generate a
lookup table that can be loaded into LogWorks for a custom input setup. See chapter 3.3 for
details.

The file that Thermistorcalc generates is named:
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Thermistor.txt

And is located in the same folder as the Thermistorcalc application.
For a typical install of the Innovate Motorsports software, this folder is:

C://[Program Files/Innovate!
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10.3 Using external MAP sensors

Many people use GM or other brand MAP sensors. These sensors output a linear 0..5V voltage
when supplied by 5V.

Typically these sensors have 3 pins. One is 5V supply, one is output and one is ground. The
sensors come in different ranges. Very typical are 1 bar (for normally aspirated engines) and 3
bar (for boosted applications).

10.3.1 Calibrating a 3 bar (or more) MAP sensor

Use a good tire pressure gauge to measure the air pressure in your spare tire. Remember, tire
pressure gauges use gauge pressure. Lower the pressure in the tire to about 29 PSI (3.013 bar
or 3.072 kg/cm”2).

Connect the tire valve to the sensor’s input port and note the output voltage. Also note the current
atmospheric pressure in inHg or millibar.

Next measure the sensor output at normal atmospheric pressure.

For LogWorks the two points needed to set up a MAP channel (absolute pressure), calculate the
absolute pressures as follows:

For PSla:

PSla = atmospheric pressure (in inHg) * 0.491 + measured pressure (in PSI)

For kPa:

kPa = atmospheric pressure (in millibar) * 0.1 + measured pressure (in bar) * 100
or

kPa = atmospheric pressure (in millibar) * 0.1 + measured pressure (in kg/cm”2) * 98.07

10.3.2 Calibrating a 1 bar MAP sensor

Calibrating a 1 bar sensor is a little more difficult than calibrating a 3 bar sensor because a
convenient vacuum source is usually not available to the average user. If you have or can borrow
a good vacuum gauge, it is easy.

Connect the vacuum gauge with a T connection to the manifold of the engine. Connect the MAP
sensor also to this T. Run the engine at idle and note the vacuum and voltage.

Then switch the engine off. The MAP sensor will measure atmospheric pressure. Note the current
atmospheric pressure in inHg or millibar.

Vacuum gauges typically measure gauge pressure in inHg or mmHg (or Torr).

For LogWorks the two points needed to set up a MAP channel (absolute pressure), calculate the
absolute pressures as follows:

For PSla:
PSla = atmospheric pressure (in inHg) * 0.491 - measured pressure (inHg) *0.491

For kPa:
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kPa = atmospheric pressure (in millibar) * 0.1 - measured pressure (mmHg or Torr) * 7.5

10.4 Measuring voltages higher than 5 Volt

Because the Innovate Motorsports devices are designed for the common 0..5V sensors, their
input range is limited to 0..5V.

A simple voltage divider can reduce the measured voltage by a certain ratio, determined by the
divider ratio, which is in turn dependent on the values of the resistors used as divider.
Alternatively a potentiometer can be used. Recommended is a 100 kOhm potentiometer. The
advantage of a potentiometer is that ANY ratio can be simply dialed in.

The following shows a simple potentiometer circuit:

Meazured Voltage LMA-Z or LMA-3

1 kOhm
CHx+
K 5.1V Zener
A& Diode

CH=- (onhy on LMA-3)

Potentiometer (100 kOhm)

Typical Zener diode

1

K A

The 1 kOhm resistor (1/8 Watt or more) and the Zener diode (1/10 Watt or more) are for
protection of the LMA-2 or LMA-3 in case the input voltage is too high and the output of the circuit
exceeds 5.1V.

Potentiometers have typically 3 pins. The middle one is the slider (indicated with an arrow or
pointer in the schematic). The other two can be connected either way as in the schematic.

To calibrate, connect the point “Measured Voltage” to the car battery and measure the voltage
between the slider of the potentiometer and ground. Also measure the battery voltage.

The divider ratio is then:

Ratio = Battery voltage / slider voltage
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10.5 Using Thermocouples

Thermocouples are nothing but two wires of different materials joined together at one end. The
materials used determine the thermocouple type. The most common is Type K.

When two different metals are joined, a voltage is create at the junction. This voltage is
determined by the temperature gradient along the wires and by the metals used. That's why only
wires of the same materials as the two thermocouple sides should be used. The voltage is very
small (in the microVolt range). Therefore it has to be amplified. Also the voltage is dependent on
the temperature gradient, meaning the temperature difference between the ends of the wire. So
the temperature of the device measuring (the cold junction) has to be known. This is called cold-
junction compensation. The LMA-3 has a thermocouple input and also provides the cold-junction
compensation.

Inserting different metals in between thermocouple and measuring device (for example to extend
the wires) should be avoided. The junction between the thermocouple wire and for example a
copper wire would also create a voltage and change the readings. That's why thermocouple wires
of the right type for each side of the thermocouple must be used.

Sometimes it is necessary that multiple thermocouples have to be logged.

The following schematic uses the AD595 integrated circuit from Analog Devices. This device is a
single chip thermocouple amplifier with cold-junction compensation. The device can be ordered
from www.digikey.com.

The circuit can measure between 0 degC (-32 degF) at OV output and 1100 degC (2012 degF) at
5V output.

12.30%
0.InF
LidAa-2 or LdA-3
Therrnocople iihamel
] ]
E1l
141312 1110 ;_;—% e
O ADSIS _ -
1234567 Rz J:
I [ 10k
ETEr
Crimel -|- Zene
= 10uF CHx- (only on LilA-3)
e 39
470
ik
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10.6 Measuring duty cycle of peak-hold injectors

Peak-Hold injectors are also called low impedance injectors. The voltage at the active pin of
those injectors during an injection pulse first goes to ground (the peak phase) and then rises to 5
to 10 Volt (the hold phase). Because for the LMA-3 everything above 2.5V is high, the LMA-3 can
see only the peak phase in many cases, but not the hold phase.

The following circuit allows the LMA-3 to be used with regular injectors as well as with peak-hold
injectors.

NOTE:

Some ECU'’s control PH injectors in PWM mode. This means that they at first ground the
injector’s active pin during the peak phase, and then rapidly switch ground on-and off
during the hold phase. This circuit will NOT work for that method of control.

12% from 124 side
Diode of injectar

14007 T LiA-2 or LA-3 @
b ' . A
A E PMP Transistor C B E
To Bl e 2nag08 3 pottom
i 2N3906 t
Injector o pinou view)
E CHixs
kOhm Diode 1N4007
—
K A
% 1 kOhm
1 CH=- (onhy on LidA-3}
— Ground-

When setting up the duty cycle measurement in LogWorks, positive duty cycle must be used
compared to negative duty cycle as when the LMA-3 is directly connected to an injector.

10.7 Making a 5 Volt supply for external sensors

This simple circuit will create a stable 5V supply from a 7-30 Volt source. Max current should be
about 300mA without heat sink on the regulator. 800-900mA with heat-sink.

LM7TE05
top view
o - GND
730v  o—) yreos MLO SV out
"
GHD | 10 uF
| 16% ol
~ zgk
[ ]

A LM340 can be used instead of an LM7805 as well. The 10uF capacitor is optional (reduces
noise).

- 100 - Logworks2_Manual_1.1.doc



10.8 And finally, a weird one

Very often one can see small front-wheel-drive cars on the road with huge wings mounted on the
trunk lid. But there’s no corresponding aerodynamic down-force device in the front. Of course, in
the majority of cases the wing is there for the ‘cool factor’ because many race-cars have wings
(birds do too, but birds also have no penis).

In a race car the wing creates aerodynamic down-force. The down force allows to increase
cornering speed because more force is put vertically on the tires without increasing the mass of
the car (which would create more side force proportionally). The aerodynamic forces created by
wings and under-car aerodynamics can be very large. For example in a Formula 1 car at speed
the down-force is twice the car’'s weight (car could drive upside down on the underside of a road
and would still stick with a force equal to its own weight).

In the above case one can only hope that these people never drive their car at speed. The down-
force of that wing, extending past the end of the car, will lift the front of the car up and make it
unstable and dangerous, especially in cross-wind situations.

But there is a legitimate need to measure down-force in a race car. Here’s how it can be done
with the MTS:

Any performance car has front- and rear sway-bars (also called anti-roll bar). These are typically
pieces of round spring steel (sometimes hollow tubes) that transfer the deflection force from the
outer wheel in a corner to the inner wheel. During that deflection the center of the sway-bar stays
pretty stationary because the bar is twisted. During normal suspension deflection on both wheels
on the axle the bar rotates with the suspension movement.

To measure down-force, one can use the car’s suspension springs a spring-scale. To do that,
fabricate a clamp-on lever that clamps to the center of the sway-bar. Use this lever to actuate a
throttle position sensor (TPS) as in the following drawing:

Clam-on lever TPS

swyay-bar rf_':1
#

Dimension the relationship between the clamp-on lever and the TPS’s lever such that the TPS
goes through its movement range of about 90 degrees for the full suspension travel.

Then hook up the TPS sensor to 5V and measure its output voltage. Load the car up with 25 Ib or
50Ib sand-bags (over the axle) and record the sensor voltage for each load to calibrate your
‘spring scale’ for each axle.

Enter that table as custom lookup table in LogWorks (voltage vs. load).

Hook the TPS sensor to the LMA-2 or LMA-3 with the following circuit:
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LiiA-2 or LidA-3

12 kOhm
TP= ELEY |—_L| n CHx+
il

CH=- {onhy on LidA-2)

The low-pass filter created by the 12 kOhm resistor and 1000 uF capacitor will filter out most
‘noise’ coming from road surface irregularities.

Note for the electronically challenged:
You can use a capacitor with a higher voltage rating than 10V also..
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11 Revision History

1.0 -- 07/15/05
Initial Release

1.1 -- 8/15/2005
General Corrections
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